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Introduction
Thank	you	for	choosing	Directories	Pro	for	WordPress,	a	suite	of	plugins	for	building	directories	on	your	WordPress
site.	Directories	Pro	lets	you	build	any	kind	of	directory	such	as	a	community	driven	local	business	directory	like
Yelp.com,	Google+	Places,	or	Yahoo!	Local,	a	user	directory,	a	website	directory,	a	property	directory,	etc.

We	hope	that	this	documentation	will	help	you	in	building	and	managing	directory	websites	with	Directories	Pro.

Introduction
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Getting	Started
In	this	section,	we	will	walk	through	the	steps	from	installation	to	setting	up	a	basic	directory	on	your	WordPress	site
with	Directories	Pro.

Getting	Started
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Installation
Follow	the	steps	below	to	complete	the	installation	of	Directories	Pro.

Check	installation	requirements
The	followings	are	required	of	your	server	(or	your	website)	to	install	Directories	Pro:

PHP	5.4.0	or	greater
MySQL	5.0.3	or	greater
WordPress	4.5.0	or	greater

Once	your	server	has	been	confirmed	to	meet	all	the	requirements	above,	proceed	to	the	next	step	to	download	and
install	Directories	Pro.

Download	package
Directories	Pro	can	be	downloaded	from	https://codecanyon.net/downloads/.	Note	that	you	will	need	to	login	with	a
CodeCanyon	(or	Envato)	account	in	order	to	have	access	to	the	download	page.	Once	you	are	on	the	page,	scroll
down	to	where	it	says	Directories	Pro	for	WordPress	and	then	click	the	green	Download	button	on	the	right	and
then	the	All	files	and	documentation	dropdown	link.	Your	browser	should	start	downloading	the	file	instantly.

Locate	the	file	downloaded	on	your	computer	(the	name	of	the	file	is	codecanyon-21800540-directories-pro-for-
wordpress.zip),	and	double	click	the	file	to	unzip	(unarchive)	the	package.	You	should	then	see	a	folder	named
DirectoriesPro-x.x.x	(where	x.x.x	represents	the	version	number)	created	containing	the	following	files:

directories-x.x.x.zip
directories-pro-x.x.x.zip
directories-frontend-x.x.x.zip
directories-payments-x.x.x.zip
directories-reviews-x.x.x.zip
directories-faker-x.x.x.zip
documentation.pdf

As	you	can	see,	Directories	Pro	consists	of	6	plugins	that	you	will	install	and	activate	on	your	site	in	the	next	step.

Install	and	Activate	Plugins
Now	that	you	have	the	plugin	files	in	hand,	follow	the	steps	below	to	install	and	activate	them	on	your	site.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Plugins	->	Add	New	from	the	side	menu.

3.	 Click	the	Upload	Plugin	link	at	the	top	of	the	page.

4.	 Click	Browse...	and	then	locate	the	directories-x.x.x.zip	file	on	your	computer.

5.	 Click	the	Install	Now	button.

6.	 Wait	until	the	page	refreshes,	and	the	click	the	Activate	Plugin	link.

Installation
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If	the	installation	is	successful,	you	will	be	redirected	to	the	Plugins	page	and	should	be	able	to	see	the
Directories	plugin	highlighted	in	blue,	which	means	the	plugin	is	installed	and	currently	active.

7.	 Repeat	steps	2-6	for	directories-pro-x.x.x.zip	(Directories	Pro	plugin).

Note:	Make	sure	the	Directories	plugin	is	already	activated.	Do	not	use	the	bulk	activation	feature.

8.	 Repeat	steps	2-6	for	directories-frontend-x.x.x.zip	(Directories	-	Frontend	plugin),	directories-reviews-
x.x.x.zip	(Directories	-	Reviews	plugin),	and	directories-payments-x.x.x.zip	(Directories	-	Payments	plugin).
Although	these	plugins	are	optional,	we	do	recommend	installing	and	activating	them	all	if	you	are	unsure.

Note:	You	can	use	the	bulk	activation	feature	to	activate	all	these	plugins	at	once.

Register	your	License	Key	(Purchase	Code)
In	order	to	protect	valid	purchasers	of	the	plugin,	some	parts	of	Directories	Pro	are	deactivated	or	inaccessible	until
your	site	is	validated	with	a	license	key.	If	you	currently	do	not	have	your	license	key	in	hand,	make	sure	to	download
one	from	https://codecanyon.net/downloads/.

Once	you	have	obtained	your	license	key,	follow	the	steps	below	to	validate	your	site.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Licenses	sub-tab.

4.	 Copy	and	paste	your	purchase	code	to	all	the	text	input	fields	displayed.

5.	 Click	Save	Changes	at	the	bottom	of	the	popup	window.

Configure	Map	Libraries
If	you	are	going	to	use	any	of	the	map	features,	you	will	also	need	to	configure	map	libraries	used	in	Directories	Pro.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Map	sub-tab.

4.	 Scroll	down	to	General	Settings	and	configure	the	following:

Installation
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Map	provider	-	Select	the	provider	of	map	tiles	used	to	render	maps.	This	is	required	to	display	or	locate
listings	on	a	map.

Google	Maps	-	free	for	mobile,	partially	free	for	web,	requires	Google	Maps	API	browser	key.

OpenStreetMap	-	free.

Geocoding	provider	-	Select	a	geocoding	service	provider	to	enable	geocoding	and	reverse	geocoding	of
addresses.	Geocoding	lets	users	search	your	directory	by	arbitrary	location	address.	Reverse	geocoding	is
used	to	find	an	address	of	a	location	when	the	map	in	the	add	listing	form	is	clicked,	and	then	auto-fill	the
address	form	field.

Google	Maps	Geocoding	-	partially	free,	requires	Google	Maps	API	browser	and	server	keys,	very
reliable.

OpenStreetMap	Nominatim	-	free,	not	very	reliable.

Mapbox	Geocoding	-	free	up	to	50,000	requests	per	month,	then	$0.50	per	1,000	requests,	requires
Mapbox	access	token.

Time	zone	API	-	Select	a	time	zone	API	used	to	fetch	the	time	zone	ID	of	a	location,	which	is	used	to
determine	whether	or	not	the	business	listing	is	currently	open	at	its	location.	The	time	zone	configured	in
WordPress	settings	will	be	used	if	none	selected.

Google	Maps	Time	Zone	-	partially	free,	requires	Google	Maps	API	browser	and	server	keys.

GeoNames	Web	Service	Timezone	-	free,	requires	GeoNames	user	name	and	their	free	web	services
enabled.

Address	autocomplete	service	-	Adds	an	autocomplete	(or	autosuggest)	feature	to	the	location	search	field
of	the	directory	search	form.

Google	Maps	Place	Autocomplete	-	partially	free,	requires	Google	Maps	API	browser	key.

Algolia	Places	Autocomplete	-	free	up	to	100,000	requests	per	month,	then	$0.40	per	1,000	requests,
requires	Algolia	application	ID	and	API	key.

Obtaining	a	Google	Maps	API	key

Note:	You	can	skip	this	section	if	you	have	not	enabled	any	of	Google	Maps	API	services.

1.	 Create	an	API	project

i.	 Make	sure	that	you	already	have	a	valid	account	from	Google	and	then	go	to	Google	API	Console.	If	you	are
not	logged	into	Google,	you	will	be	prompted	to	login	first.

Installation
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ii.	 On	the	Dashboard	page	of	Google	API	Console,	create	a	new	project	or	select	an	existing	project.

iii.	 Click	+ENABLE	APIS	AND	SERVICES	and	enable	the	following	APIs	found	under	the	Maps	category:

Google	Maps	JavaScript	API	-	required	if	Map	provider	is	Google	Maps.

Google	Maps	Geocoding	API	-	required	if	Geocoding	provider	is	Google	Maps	Geocoding.

Google	Maps	Time	Zone	API	-	required	if	Time	zone	API	is	Google	Maps	Time	Zone.

Google	Places	API	Web	Service	-	required	if	Address	autocomplete	service	is	Google	Maps	Places
Autocomplete.

2.	 Generate	a	browser	key

A	server	key	is	required	to	use	Google	Maps	JavaScript	API,	Google	Maps	Time	Zone	API	or	Google	Places	API
Web	Service	with	Directories	Pro.

Follow	the	steps	below	to	create	a	browser	key	for	Google	Maps	API:

i.	 On	the	Credentials	page,	click	the	Create	credentials	dropdown	button	and	click	API	key.

ii.	 On	the	API	key	created	popup,	click	RESTRICT	KEY.

iii.	 Under	Key	restrictions	->	Application	restrictions,	select	HTTP	referrers	(web	sites)	and	enter	the	URL
of	your	site.

iv.	 Scroll	down	and	click	Save.

3.	 Generate	a	server	key

A	server	key	is	required	to	use	Google	Maps	Geocoding	API	or	Google	Maps	Time	Zone	API	with	Directories
Pro.

Follow	the	steps	below	to	create	a	server	key	for	Google	Maps	API:

i.	 On	the	Credentials	page,	click	the	Create	credentials	dropdown	button	and	click	API	key.

ii.	 On	the	API	key	created	popup,	click	RESTRICT	KEY.

iii.	 Under	Key	restrictions	->	Application	restrictions,	select	IP	addresses	and	enter	the	IP	address	of	your
server.

iv.	 Scroll	down	and	click	Save.

4.	 Enable	billing

As	of	July	16,	2018,	Google	requires	you	to	enable	billing	for	each	of	your	API	projects	in	order	to	use	their
Google	Maps	APIs.	To	enable	billing,	click	the	following	link	to	Google	Cloud	Platform	and	follow	the	instructions
displayed.	https://console.cloud.google.com/projectselector/billing/enable

Installation
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Creating	Your	First	Directory
Now	that	you	have	installed	Directories	Pro,	you	are	ready	to	start	adding	directories	to	your	site.

Follow	the	steps	below	to	create	a	new	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Add	Directory	green	button	under	the	All	Directories	tab	which	will	open	a	popup	window.

4.	 In	the	popup	window,	choose	Configure	a	new	directory	for	Choose	a	method.

5.	 Configure	the	following	settings	for	your	directory.

Directory	label	-	Enter	a	label	for	your	directory	which	is	used	for	administration	purpose	only.	This	will	also
be	used	as	the	menu	item	label	of	the	directory	in	the	admin	sidebar.

Directory	name	-	Enter	a	machine	readable	name	which	may	not	be	changed	later.	Only	lowercase
alphanumeric	characters	and	underscores	are	allowed	with	maximum	of	12	characters.

Directory	icon	-	Select	an	icon	to	be	displayed	for	the	menu	item	of	the	directory	in	the	admin	sidebar.

Creating	Your	First	Directory

9



Enable	categories	-	Whether	or	not	to	enable	categories	for	your	directory.	Categories	can	be	used	to
organize	listings	in	hierarchical	groups.

Enable	tags	-	Whether	or	not	to	enable	tags	for	your	directory.	Tags	can	be	used	to	organize	listings	in
groups	according	to	common	keywords	or	phrases.

Enable	reviews	-	Whether	or	not	to	allows	users	to	submit	reviews	for	listings	with	customizable	rating
criteria.	See	Reviews	for	more	details.

Enable	search	-	Whether	or	not	to	enable	the	search	feature	which	lets	you	create	a	search	form	for	your
directory.

Enable	payments	-	Whether	or	not	to	enable	paid	listings	in	your	directory.	See	Monetization	for	more
details.

Enable	claims	-	Whether	or	not	to	allow	users	to	claim	their	listings.	See	Claiming	Listings	for	more	details.

Enable	locations	-	Whether	or	not	to	enable	locations	for	your	directory.	Locations	can	be	used	to	organize
and	display	listings	in	groups	by	geographical	location.

Note:	The	subsequent	pages	of	this	chapter	assume	that	you	have	enabled	all	the	features	above.

6.	 Once	you	are	ready,	click	the	Add	Directory	button	at	the	bottom	of	the	popup	window.	A	progress	bar	will	show
up	indicating	the	status	of	the	directory	creation	process.	Make	sure	that	you	do	not	close	the	window	until	the
process	is	complete.

When	the	process	is	complete,	the	pop	window	closes	and	you	will	be	redirected	to	the	main	administration	page
of	the	directory	created.

Creating	Your	First	Directory
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From	this	page	you	can	configure	settings,	content	types,	and	permissions	of	the	directory.

Also	notice	that	a	new	menu	section	for	the	directory	has	been	added	to	the	admin	sidebar	containing	links	to
manage	content	of	your	directory.	If	the	label	of	your	directory	is	"Restaurants",	then	you	will	see	a	new	menu
section	labelled	"Restaurants"	created	as	shown	below:

Congratulations,	you	have	successfully	created	your	first	directory!

Creating	Your	First	Directory
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Adding	and	Managing	Listings
Listings	in	Directories	Pro	are	a	custom	post	type,	therefore	you	can	create	them	in	the	same	way	as	blog	posts	and
pages	in	WordPress.

Adding	a	listing
Follow	the	steps	below	to	add	a	listing	to	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Add	Listing	under	your	directory	menu	in	the	admin	sidebar.

The	Add	Listing	page	should	look	like	below.

Adding	and	Managing	Listings
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Enter	the	title	of	your	listing	into	the	text	field	where	it	says	Enter	title	here.

3.	 Next,	enter	detailed	information	of	your	listing	to	the	fields	under	the	Listing	Fields	section	where	the	following
fields	are	available	by	default.

Location	-	Enter	the	location	of	the	listing.

Adding	and	Managing	Listings
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You	can	also	have	the	field	filled	out	automatically	by	clicking	on	the	map.

Clicking	on	the	map	will	also	automatically	assign	values	to	each	address	component	of	the	field	and
latitude/longitude	coordinates.	If	you	prefer	entering	or	selecting	the	fields	manually,	check	the	Enter
address	details	manually	checkbox	below	the	map	which	will	reveal	additional	fields.

Adding	and	Managing	Listings
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Note:	If	you	are	seeing	an	error	message	such	as	"Oops!	Something	went	wrong."	on	the	map	as	shown
below,	make	sure	that	you	have	configured	an	API	key	for	Google	Maps	API.	See	Setting	up	Google	Maps
API	for	more	details.

Phone	Number	-	Enter	the	phone	number	of	the	listing.

Fax	Number	-	Enter	the	fax	number	of	the	listing.

E-mail	Address	-	Enter	the	contact	E-mail	address	of	the	listing.

Website	URL	-	Enter	the	website	URL	of	the	listing.

Social	Accounts	-	Enter	social	media	accounts	associated	with	the	listing.	Some	accounts	require	a	full
URL	while	others	require	only	a	user,	page,	or	hashtag	name.

Adding	and	Managing	Listings

15



Listing	Description	-	Enter	the	detailed	description	of	the	listing.	Shortcodes	may	be	used	in	this	field.

Photos	-	Upload	photos	of	the	listing.	If	multiple	photos	are	uploaded,	the	photo	in	the	first	table	row	of	the
field	will	become	the	featured	photo.	You	can	drag	the	rows	in	the	table	to	swap	the	featured	photo	or
rearrange	the	display	order	of	photos.

Adding	and	Managing	Listings
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Opening	Hours	-	Select	a	day	of	week	and	specify	a	time	range.	You	can	add	as	many	entries	as	you	wish
by	clicking	on	the	Add	More	button.

Date	Established	-	Click	inside	the	text	box	to	open	a	date	picker	popup	and	select	a	date.

Price	Range	-	Specify	a	price	range	by	dragging	the	circles	on	the	sides.

4.	 Some	other	fields	available	on	the	side	are	as	follows:

XXXX	-	Categories	(where	XXXX	is	the	directory	label)	-	Select	from	existing	categories	or	create	new
categories	for	the	listing.

XXXX	-	Tags	(where	XXXX	is	the	directory	label)	-	Select	from	existing	tags	or	create	new	tags	for	the	listing.

Adding	and	Managing	Listings
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Author	-	Set	the	author	of	the	listing.	If	no	author	is	selected,	then	the	listing	becomes	claimable	and	users
with	a	valid	permission	will	be	able	to	claim	the	listing	and	become	the	author.	See	Claiming	Listings	for	more
details.

Featured	Content	-	Select	Yes	to	make	the	listing	featured.

The	Priority	option	specifies	the	priority	of	the	listing	within	all	featured	listings.	Featured	listings	with	a
higher	priority	level	are	displayed	above	featured	listings	with	lower	priority	levels	when	listings	are	sorted	by
featured	listings	first.

End	Date	specifies	the	date	at	which	the	listing	is	un-featured.

5.	 Click	the	Publish	button	to	create	and	publish	your	listing	immediately,	or	click	Save	Draft	to	publish	it	later.

Editing	a	listing
To	edit	a	listing:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	All	Listings	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	listings	table,	hover	over	to	the	row	of	the	listing	that	you	wish	to	edit	and	click	the	Edit	link	that	appears	in
the	Title	column.

4.	 Make	any	changes	needed	to	the	listing	and	then	click	Update.

Deleting	a	listing

Adding	and	Managing	Listings
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To	delete	a	listing:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	All	Listing	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	listings	table,	hover	over	to	the	row	of	the	listing	that	you	wish	to	delete	and	click	the	Trash	link	that
appears	in	the	Title	column.	This	will	move	the	listing	to	Trash.

4.	 In	order	to	permanently	delete	the	listing,	click	the	Trash	link	above	the	listings	table,	find	the	listing	that	has	just
been	moved	to	trash	and	then	click	Delete	Permanently.

Adding	and	Managing	Listings
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Adding	and	Managing	Categories	and	Tags
Categories	and	tags	in	Directories	Pro	are	used	to	organize	listings	into	groups,	just	like	categories	and	tags	you	have
when	writing	posts	in	WordPress.	For	example,	a	business	directory	may	have	categories	such	as	Restaurants,
Shopping,	Education,	Hotels,	and	tags	like	Good	for	kids,	Has	parking,	and	Alcohol.	The	difference	between
categories	and	tags	is	that	categories	are	hierarchical	in	structure	while	tags	are	a	flat	namespace.

Adding	a	category
Follow	the	steps	below	to	create	a	category	for	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Categories	under	your	directory	menu	in	the	admin	sidebar.

3.	 To	add	a	category,	use	the	Add	Category	form	displayed	next	to	the	category	list	table	as	shown	below:

Managing	Categories	and	Tags
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Name,	Slug,	Parent	Category,	Description	-	Enter	these	fields	as	you	do	with	categories	for	posts	in
WordPress.

Category	Color,	Category	Icon	-	Select	an	icon	and	a	color	that	best	represents	the	category.

4.	 Click	the	Add	Category	button	to	add	your	category.

Adding	a	tag
Follow	the	steps	below	to	create	a	tag	for	your	directory.

Managing	Categories	and	Tags
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1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Tags	under	your	directory	menu	in	the	admin	sidebar.

3.	 To	add	a	tag,	use	the	Add	Tag	form	displayed	next	to	the	tag	list	table	as	shown	below:

Enter	Name,	Slug,	and	Description	fields	as	you	do	with	tags	for	posts	in	WordPress.

4.	 Click	the	Add	Tag	button	to	add	your	tag.

Editing	a	category/tag
To	edit	a	category/tag:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Categories	or	Tags	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	category/tag	list	table,	hover	over	to	the	row	of	the	category/tag	that	you	wish	to	edit	and	click	the	Edit	link
that	appears	in	the	Name	column.

4.	 Make	any	changes	needed	and	then	click	Update.

Deleting	a	category/tag
To	delete	a	category/tag:
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1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Categories	or	Tags	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	category/tag	list	table,	hover	over	to	the	row	of	the	category/tag	that	you	wish	to	delete	and	click	the	Delete
link	that	appears	in	the	Name	column.

4.	 In	the	popup	window,	click	OK	to	delete	the	category/tag.
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Managing	Locations
Locations	let	you	group	listings	geographically,	such	as	by	countries,	states,	and/or	cities.	Locations	is	a	custom
taxonomy	and	are	hierarchical	in	structure	just	like	categories.

Setting	up	location	hierarchy
Before	adding	locations	to	your	directory,	the	location	hierarchy	must	first	be	defined.	By	default,	the	location
hierarchy	is	configured	as	Country	->	State	/	Province	/	Region	->	City.	That	is,	locations	at	the	first	level	of	the
hierarchy	are	treated	as	countries,	locations	at	the	second	level	as	states,	provinces,	or	regions,	and	locations	at	the
third	level	as	cities.

If	you	wish	to	change	the	default	configuration;	for	example	you	may	want	to	add	a	new	Town	level	under	City,	or
remove	the	Country	level	because	your	listings	are	all	located	within	a	single	country;	you	may	do	so	by	following
these	steps.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Location	row.

5.	 Scroll	down	to	the	Location	Hierarchy	Settings	section	and	select	Yes	for	Enable	custom	location	hierarchy.

Here	you	can	modify	labels,	remove	one	or	more	levels	in	the	hierarchy,	and/or	add	new	levels	to	the	hierarchy.

Note:	If	you	remove	all	the	options,	listings	can	not	be	associated	with	locations.

6.	 After	making	changes,	scroll	down	the	page	and	click	Save	Changes.

Adding	a	location
Follow	the	steps	below	to	add	a	location	to	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Locations	under	your	directory	menu	in	the	admin	sidebar.
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3.	 Use	the	Add	Location	form	displayed	next	to	the	location	list	table	as	shown	below:

Enter	the	Name	of	location	and	then	optionally	fill	out	the	Slug	and	Description	fields,	select	a	Parent	Location
and/or	upload	a	photo	for	the	location	from	the	Photo	field.

4.	 Click	the	Add	Location	button	to	add	your	location.

Editing	a	location
To	edit	a	location:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Locations	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	location	list	table,	hover	over	to	the	row	of	the	location	that	you	wish	to	edit	and	click	the	Edit	link	that
appears	in	the	Name	column.

4.	 Make	any	changes	needed	to	the	location	and	then	click	Update.

Deleting	a	location
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To	delete	a	location:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Locations	under	your	directory	menu	in	the	admin	sidebar.

3.	 In	the	location	list	table,	hover	over	to	the	row	of	the	location	that	you	wish	to	delete	and	click	the	Delete	link	that
appears	in	the	Name	column.

4.	 In	the	popup	window,	click	OK	to	delete	the	location.

Assigning	locations	to	listings
Locations	can	be	assigned	to	listings	just	like	categories	and	tags.	However,	unlike	categories	and	tags,	the	field	for
selecting	a	location	is	displayed	under	the	Listings	Fields	metabox	along	with	address	and	map	fields	as	shown
below.

Dropdown	fields	(Country,	State,	and	City	fields	in	the	screenshot	above)	are	displayed	for	specifying	a	location	for
the	listing,	each	field	corresponding	to	a	single	level	in	the	location	hierarchy.	Note	that	you	will	need	to	actually	select
an	option	from	each	dropdown	field	in	order	to	reveal	subsequent	level	dropdown	fields.
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Displaying	Content	with	Views
What	are	views?	A	view	is	simply	a	set	of	criteria	and	configurations	to	query,	sort,	and	display	content	items	in
various	ways.	For	example,	you	can	use	views	to	display	listings	in	a	standard	list	format,	a	photo	slider,	on	a	map
with	map	markers,	or	display	photos	of	locations	in	a	masonry	layout.	Views	are	enabled	for	listings,	categories,	tags,
locations,	and	reviews	in	Directories	Pro.

Configuring	the	default	view	for	listings
Listings	shown	on	the	directory	index	page	and	single	taxonomy	pages	of	your	directory	in	the	frontend	are	displayed
by	a	single	view	setup	for	listings	by	default	(hereafter	"default	view").	You	can	customize	how	and	what	listings	are
displayed	on	those	pages	by	modifying	the	settings	of	the	default	view.

Follow	the	steps	below	to	configure	the	default	view.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Views.

As	can	be	seen	above,	there	is	already	a	view	created	for	listings.	Also	notice	the	green	check	icon	shown	for	the
view	in	the	Default	column	which	indicates	that	the	view	is	a	default	view.

5.	 To	configure	the	view,	click	the	gear	icon	in	the	row	of	the	view.

General	Settings

View	label	-	Label	of	the	view	used	for	administration	purpose	only.
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View	name	-	Unique	name	assigned	to	the	view	so	that	it	can	easily	be	referenced.	Only	lowercase
alphanumeric	characters	and	underscores	are	allowed.

View	mode	-	Mode	(or	format)	used	to	display	content	items	with	the	view.	By	default	there	are	3	view
modes	available	for	listings;	List,	Masonry,	and	Photo	Slider	view	modes.

The	following	are	sample	outputs	of	listings	for	each	view	mode.

List	view	-	default,	with	map,	with	map	above

Masonry	view	-	default

Photo	slider	view	-	default

Map	view	-	default

View	Mode	Settings	-	Shows	settings	specific	to	the	view	mode	selected	under	General	Settings.

Settings	specific	to	List	view	mode:

Enable	grid	layout	-	Whether	or	not	to	enable	displaying	items	in	grid	layout.

Disable	row	layout	-	Whether	or	not	to	disable	displaying	items	in	row	layout.

Set	grid	layout	as	default	-	Whether	or	not	to	display	items	in	grid	layout	by	default.

Grid	layout	gutter	width	-	Width	of	gutters	between	items	in	grid	layout.

Grid	layout	columns	-	Select	the	number	of	columns	shown	in	Grid	layout.

Settings	specific	to	Masonry	view	mode:

Number	of	columns	-	Select	the	number	of	columns	shown	in	masonry	layout.
Settings	specific	to	List/Masonry/Map	view	mode:

Show	map	-	Whether	or	not	to	display	a	small	map	along	with	the	list	of	listings.

Map	coordinates	field	-	Field	that	provides	lat/lng	coordinates	to	show	on	map.

Map	position	-	Select	where	to	display	the	small	map,	above	or	next	to	the	list	of	listings.

Map	width	-	Specify	the	horizontal	display	ratio	of	the	map,	12	being	100%	wide.

Map	height	-	Height	of	the	map	in	pixels.

Map	marker	icon	-	Select	what	to	show	as	an	icon	inside	map	markers.

Scroll	to	item	on	marker	click	-	Whether	or	not	to	scroll	the	screen	to	the	position	where	the	listing
is	displayed	in	the	list	when	a	marker	on	the	map	is	clicked.

Enable	sticky	map	-	Whether	or	not	to	make	the	map	stick	to	the	top	of	the	viewport	when	scrolling
up	and	down	the	list.

Enable	full	screen	mode	-	Whether	or	not	to	allow	viewing	the	list	and	the	map	in	full	screen.
When	enabled,	a	button	will	be	displayed	on	the	map	to	toggle	full	screen	mode.

Full	screen	map	width	-	Specify	the	horizontal	display	ratio	of	the	map	on	the	page	when	in	full
screen	mode,	where	12	being	100%	wide.

Enable	map	infobox	-	Whether	or	not	to	display	a	small	popup	window	(infobox)	over	the	map
containing	listing	information	when	a	marker	is	clicked	on	the	map.

Map	infobox	width	-	Specify	the	width	of	the	map	infobox	in	pixels.
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Open	infobox	on	item	hover	-	Whether	or	not	to	show	the	map	infobox	when	hovering	over	listings
in	the	list.

Customize	format	of	address	on	infobox	-	Whether	or	not	to	specify	a	custom	format	for	the
address	shown	in	the	map	infobox.

Settings	specific	to	Photo	slider	view	mode:

Image	field	-	Select	the	field	used	to	display	a	photo	image	for	each	content	item	in	the	slider.

Image	size	-	Select	the	size	of	photo	images	in	the	slider.

Number	of	columns	-	Select	the	number	of	columns	to	display	in	each	slide.

Show	slide	indicators	-	Whether	or	not	to	show	small	dot	slide	indicators.

Show	prev/next	arrows	-	Whether	or	not	to	show	prev/next	navigation	arrows.

Show	photo	captions	-	Whether	or	not	to	show	a	caption	text	for	each	photo.

Autoplay	slides	-	Whether	or	not	to	automatically	play	the	slides	when	the	slider	is	loaded.

Autoplay	speed	in	milliseconds	-	Specify	the	slider	autoplay	speed	in	milliseconds.

Enable	centered	view	-	Whether	or	not	to	enable	centered	view	with	partial	prev/next	slides.

Fade	in/out	slides	-	Whether	or	not	to	use	fade	in/out	effect	instead	of	sliding.

Slider	height	-	Set	the	height	of	the	slider	in	pixels.

Photo	padding	-	Set	the	length	of	horizontal	padding	applied	to	each	photo	in	pixels.

Show	thumbnails	-	Whether	or	not	to	show	a	thumbnail	navigation.

Number	of	thumbnail	columns	-	Select	the	number	of	thumbnail	columns	to	display	in	the
thumbnail	navigation.

Settings	commonly	available	with	every	view	mode	(except	for	some	that	may	not	exist	for	certain	view
modes):

SORT	SETTINGS
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Sort	options	-	Select	sorting	options	that	should	be	available	in	the	Sort	by	dropdown
displayed	above	content	items.	You	can	change	the	display	order	of	the	options	by	dragging
them	up	and	down.	You	can	also	unselect	all	options	to	disable	the	Sort	By	dropdown.

Default	sort	order	-	Select	the	sort	option	that	should	be	applied	by	default.	Make	sure	to
select	one	from	the	ones	enabled	for	Sort	options,	otherwise	the	first	sort	option	available	will
be	used	as	the	default.

Show	featured	items	first	-	Whether	or	not	to	display	featured	items	above	those	non-
featured.

PAGINATION	SETTINGS

Disable	pagination	-	Whether	or	not	to	completely	disable	pagination.

Items	per	page	-	Set	the	number	of	items	to	show	per	page.

Allow	selection	of	number	of	items	per	page	-	Whether	or	not	to	let	viewers	select	the
number	of	items	shown	per	page.

Allowed	number	of	items	per	page	-	Select	the	number	of	items	per	page	options	available
for	the	viewers	to	choose	from.

QUERY	SETTINGS

Query	by	field	-	By	default,	the	view	will	display	all	public	(and	private	if	allowed	in	permission
settings)	listings.	If	you	wish	to	display	a	certain	type	of	listings	only,	e.g.	featured	listings,
listings	that	belong	to	certain	categories,	listings	with	a	certain	custom	field	value,	you	can	do
so	by	adding	custom	query	criteria	using	this	setting.

Select	a	field	from	the	dropdown	and	then	enter	a	value	into	the	next	text	box	specific	to	the
selected	field.	Click	inside	the	text	box	to	display	a	tip	on	what	value	you	can	enter	for	the	field.
You	can	add	as	many	field	criteria	as	you	like	by	pressing	the	Add	More	button.

Max	number	of	items	to	query	(0	=	unlimited)	-	Specify	the	maximum	number	of	items	to
query	from	the	database.	Enter	0	to	fetch	all	that	match	the	query.
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FILTER	SETTINGS

Show	filter	form	-	Whether	or	not	to	display	a	filter	form.	For	more	details	on	filters,	see	Adding
and	Managing	Filters.

Disable	collapsing	filter	form	-	Switch	on	this	option	to	disable	collapsing	of	the	filter	form	and
keep	it	always	visible.

Show	filter	form	in	modal	window	-	Whether	or	not	to	display	a	filter	form	in	a	modal	popup
window	instead	of	displaying	the	form	above	content	items.

OTHER	SETTINGS

Show	number	of	items	found	-	Whether	or	not	to	show	the	total	number	of	content	items
found	as	well	as	the	number	of	items	currently	displayed	on	the	page.

Show	"Add	Listing"	button	-	Whether	or	not	to	show	a	button	which	links	to	the	Add	Listing
page.

6.	 Click	Save	Changes	to	save	the	view.

Adding	a	view
You	can	create	additional	views	for	each	content	type	which	can	then	be	displayed	using	a	shortcode.

Follow	the	steps	below	to	add	a	new	view	for	listings	to	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Views.

5.	 Click	the	Add	View	green	button.

6.	 Configure	the	view.	See	the	Configuring	the	default	view	for	listings	section	above	for	details	on	each	setting.

7.	 Scroll	down	the	page	and	press	Save	Changes.
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You	will	be	redirected	back	to	the	manage	views	page	if	the	view	is	created	successfully.	You	can	then	optionally	set
the	view	as	the	default	view	by	clicking	on	the	greyed	out	check	icon	under	the	Default	column	in	the	row	of	the	view
just	created.

Note:	There	can	only	be	one	default	view	for	each	content	type	in	your	directory.

Adding	a	view	for	other	content	types

The	steps	for	adding	or	configuring	a	view	for	other	content	types	are	exactly	the	same	as	above	for	listings.	Simply
go	to	the	Manage	Views	page	for	each	content	type	from	the	Content	Types	tab	of	your	directory	admin	page	and
add	or	configure	views	from	there.

Displaying	a	view	with	shortcode
Views	can	also	be	displayed	using	shortcodes.	Copy	the	shortcode	text	displayed	in	the	Shortcode	column	for	each
view	and	then	paste	the	copied	text	to	the	content	section	of	any	WordPress	post/page	or	use	it	in	your	theme
template	file	with	the	do_shortcode()	function.

You	can	optionally	use	the	cache	parameter	to	cache	the	content	generated	by	the	shortcode,	for	example:

[drts-directory-view	directory="directory"	cache="1"]

This	lets	the	content	generated	by	the	shortcode	to	be	cached	for	a	day	by	default.	If	you	need	to	increase	or
decrease	the	cache	duration,	you	can	instead	pass	a	cache	lifetime	value	in	seconds	using	the	cache	parameter.	For
example,	the	code	below	tells	the	content	to	be	cached	for	an	hour	(3600	seconds):

[drts-directory-view	directory="directory"	cache="3600"]

Deleting	a	view
To	delete	a	view,	click	the	button	with	a	red	cross	icon	in	the	row	of	the	view	that	you	wish	to	delete,	and	then	click	the
Delete	View	button	in	the	popup	window.
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Note:	You	can	not	delete	a	view	that	is	currently	set	as	the	default	view.

Examples
Here	are	some	examples	of	views	and	instructions	on	how	to	configure	them.

Recent	Listings

Display	4	most	recent	listings:

1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Listing	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Recent	Listings	for	View	label.
4.	 Select	List	for	View	mode.
5.	 Switch	on	Disable	row	layout.
6.	 Under	the	Sort	Settings	tab,	check	Newest	First	and	uncheck	all	others	for	Sort	options.
7.	 Select	Newest	first	for	Default	sort	order.
8.	 Under	the	Query	Settings	tab,	enter	4	for	Max	number	of	items	to	query	(0	=	unlimited).
9.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
10.	 Copy	the	shortcode	generated	for	the	view	and	use	it	on	any	page.

Categories

Display	all	categories	in	grid	layout	grouped	by	top	level	categories:
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1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Category	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Categories	for	View	label.
4.	 Select	List	for	View	mode.
5.	 Switch	on	Disable	row	layout.
6.	 Select	Medium	width	for	Grid	layout	gutter	width.
7.	 Under	the	Sort	Settings	tab,	check	Title	and	uncheck	all	others	for	Sort	options.
8.	 Select	Title	for	Default	sort	order.
9.	 Under	the	Query	Settings	tab,	select	Parent	Category	-	Parent	Term	and	enter	0	in	the	text	field	for	Query	by

field.
10.	 Under	the	Pagination	tab,	switch	on	Disable	pagination.
11.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
12.	 Copy	the	shortcode	generated	for	the	view	and	use	it	on	any	page.

Popular	Locations

Display	12	random	locations	that	have	a	photo	and	at	least	3	listings:
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1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Location	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Popular	Locations	for	View	label.
4.	 Select	Masonry	for	View	mode.
5.	 Under	the	Sort	Settings	tab,	check	Random	and	uncheck	all	others	for	Sort	options.
6.	 Select	Random	for	Default	sort	order.
7.	 Click	the	Query	Settings	tab,	scroll	down	to	Query	by	field.	Select	Photo	-	Image	and	enter	1	in	the	text	field.

Click	Add	More,	select	Term	content	count	-	Term	content	count	and	enter	3	in	the	text	field.
8.	 Enter	12	for	Max	number	of	items	to	query	(0	=	unlimited).
9.	 Under	the	Pagination	tab,	switch	on	Disable	pagination.
10.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
11.	 Copy	the	shortcode	generated	for	the	view	and	use	it	on	any	page.

Featured	Listings

Display	maximum	of	12	random	featured	listings	in	a	photo	slider:

1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Listing	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Featured	Listings	for	View	label.
4.	 Select	Photo	slider	for	View	mode.
5.	 Select	Photos	(Image)	for	Image	field.
6.	 Select	Thumbnail	for	Image	size.
7.	 Select	5	for	Number	of	columns.
8.	 Switch	on	Enable	centered	view.
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9.	 Switch	on	Disable	row	layout.
10.	 Enter	135	for	Slider	height.
11.	 Enter	5	for	Photo	padding.
12.	 Under	the	Sort	Settings	tab,	check	Random	and	uncheck	all	others	for	Sort	options.
13.	 Select	Random	for	Default	sort	order.
14.	 Under	the	Query	Settings	tab,	select	Featured	Content	-	Featured	Content	and	enter	1	in	the	text	field	for	Query

by	field.
15.	 Under	the	Query	Settings	tab,	enter	12	for	Max	number	of	items	to	query	(0	=	unlimited).
16.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
17.	 Copy	the	shortcode	generated	for	the	view	and	use	it	on	any	page.

Recent	Reviews

Display	6	most	recent	reviews	in	masonry	layout:

1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Review	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Recent	Reviews	for	View	label.
4.	 Select	Masonry	for	View	mode.
5.	 Under	the	Sort	Settings	tab,	check	Newest	First	and	uncheck	all	others	for	Sort	options.
6.	 Select	Newest	first	for	Default	sort	order.
7.	 Under	the	Query	Settings	tab,	enter	6	for	Max	number	of	items	to	query	(0	=	unlimited).
8.	 Under	the	Pagination	tab,	switch	on	Disable	pagination.
9.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
10.	 Copy	the	shortcode	generated	for	the	view	and	use	it	on	any	page.
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Nearby	Listings

Display	maximum	of	10	nearby	listings	within	20km	(or	20mi)	from	the	location	of	the	currently	viewed	listing	sorted	by
distance:

1.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Listing	->	Manage	Views.
2.	 Click	the	Add	View	button.
3.	 Enter	Nearby	Listings	for	View	label.
4.	 Select	List	for	View	mode.
5.	 Under	the	Sort	Settings	tab,	check	Distance	and	uncheck	all	others	for	Sort	options.
6.	 Select	Distance	for	Default	sort	order.
7.	 Under	the	Query	Settings	tab,	select	Location	-	Location	and	enter	_current_,20	in	the	text	field	for	Query	by

field.
8.	 Click	the	Add	more	button,	select	ID	-	ID	and	enter	-_current_	(do	not	forget	to	prefix	with	"-")	in	the	text	field.
9.	 Under	the	Query	Settings	tab,	enter	10	for	Max	number	of	items	to	query	(0	=	unlimited).
10.	 Click	the	Add	View	button	at	the	bottom	of	the	popup	window.
11.	 Copy	the	shortcode	generated	for	the	view.
12.	 Go	to	Directories	->	[Your	Directory]	->	Content	Types	->	Listing	->	Manage	Displays.
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13.	 Click	the	Detailed	sub-tab.
14.	 Click	the	green	+	button	at	the	bottom.
15.	 In	the	popup	window,	click	the	Content	tab	and	then	click	the	Text	element.
16.	 Under	the	General	tab,	paste	the	shortcode	copied	in	step	10	into	the	Text	content	textarea	field.
17.	 Under	the	Heading	tab,	select	Custom	label	for	Label	and	enter	Nearby	Listings	into	the	Custom	label	setting

field.
18.	 Click	the	Add	Element	button	at	the	bottom	of	the	popup	window.
19.	 Press	Save	Changes	at	the	bottom	of	the	page.
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Adding	and	Managing	Fields
Posts	and	taxonomy	terms	in	Directories	Pro	are	composed	of	pre-defined	set	of	fields.	These	are	called	default
fields,	which	are	defined	automatically	and	only	once	during	plugin	activation.

On	the	other	hand,	custom	fields	are	fields	that	can	be	defined	manually	in	addition	to	the	default	fields.	These	fields
are	used	to	store	and	display	additional	pieces	of	information	for	each	content	item,	and	can	be	freely	defined	or
deleted.

Editing	a	default	field
We	will	explain	here	in	detail	how	you	can	edit	a	default	field,	by	actually	editing	one	of	the	default	fields	defined	for
listings.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	that	you	wish	to	configure.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Fields.
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This	page	shows	a	drag	and	drop	editor	that	lets	you	manage	fields	for	listings.	It	lets	you	design	the	listing
submission	form	used	both	in	the	backend	and	the	frontend.	Each	grey	box	in	the	editor	is	referred	to	as	an
element	in	this	documentation.

5.	 Hover	over	to	the	Listing	Description	element	and	click	the	gear	icon	which	will	open	a	popup	window
containing	a	configuration	form	for	the	element.

General	Settings	-	Configure	general	settings	of	the	element.	The	options	displayed	here	depend	on	the
type	of	the	element	currently	being	edited.

Some	notable	options	are:

Label	-	Label	for	the	field	in	the	add	listing	form.	This	setting	may	not	be	empty.

Form	field	type	-	Choose	how	the	field	is	displayed	in	the	listing	submission	form.

Visibility	Settings	-	Shows	settings	related	with	the	visibility	of	the	element,	such	as	an	option	to	restrict	the
element	to	be	viewed	by	certain	user	roles.

Advanced	Settings	-	Shows	a	setting	for	adding	a	CSS	class	to	the	element.

6.	 Select	Textarea	field	for	Form	field	type	under	the	General	Settings	tab.
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7.	 Press	the	Save	Changes	button.

Now	that	the	form	field	type	of	the	field	has	been	changed	from	WordPress	editor	to	Textarea	field,	click	Add
Listing	under	your	directory	menu	in	the	admin	sidebar.

As	you	can	see,	the	Listing	Description	field	now	displays	a	simple	textarea	field	instead	of	the	default	WordPress
rich	text	editor.

Adding	a	custom	field
We	will	explain	here	how	you	can	define	a	custom	field,	by	actually	adding	a	new	custom	field	to	listings.

1.	 On	the	form	editor	page,	click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom	of	the	page:

A	popup	window	will	appear	as	below:
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2.	 Click	the	Field	tab,	hover	over	to	the	Choice	element	and	click.
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General	Settings

Enter	or	select	the	following	values	for	each	setting:

Label	-	Features

Field	name	-	features

Options	-	Click	the	Add	from	CSV	button,	then	copy	&	paste	the	whole	text	below	into	the	textarea.

Takes	Reservations,reservation,fa-phone

Accepts	Credit	Cards,cc,fa-credit-card

Apple	Pay,applep,fab	fa-apple-pay

Delivery,delivery,fa-motorcycle

Outdoor	Seating,outdoor,fa-tree

Good	for	Kids,kids,fa-child

Good	for	Groups,groups,fa-users

Waiter	Service,waiter,fa-user
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Take-out,takeout,fa-shopping-bag

Wheelchair	Accessible,wheelchair,fa-wheelchair

Has	TV,tv,fa-tv

Dogs	Allowed,dogs,fa-paw

Sells	Gift	Certificates,gift,fa-gift

Alcohol,alcohol,fa-beer

Has	Music,music,fa-music

Karaoke,karaoke,fa-microphone

Parking	Lot,parking,fa-car

Valet	Parking,valet,fa-taxi

Free	Wifi,wifi,fa-wifi

Smoking	Allowed,smoking,fa-fire

Shower,shower,fa-shower

Form	field	type	-	Checkboxes

Display	inline	-	No

Number	of	columns	-	3

Max	number	of	values	-	Unlimited

3.	 Press	the	Add	Element	button	at	the	bottom	of	the	popup	window.	A	new	field	element	labelled	Features	will	be
added	to	the	editor	as	below.

Now,	visit	the	Add	Listing	page	of	your	directory.	You	should	see	the	newly	added	Features	field	in	the	add	listing
form	as	below.
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Deleting	a	custom	field
Follow	the	instructions	below	to	delete	a	custom	field.

1.	 On	the	form	editor	page,	hover	over	to	the	custom	field	element	which	you	wish	to	delete,	and	then	click	the	red
trash	icon.

2.	 Click	OK	in	the	popup	alert	box.

3.	 The	field	element	will	disappear	and	is	removed	from	the	add	listing	form.

Re-using	custom	fields
Custom	fields	are	re-useable.	That	is,	you	can	add	custom	fields	that	you	have	created	previously	to	another	content
type	in	the	same	directory	or	to	content	types	of	other	directories.	Note	that	you	can	not	add	a	custom	field	again	to	a
content	type	that	already	has	the	field	assigned.

In	order	to	re-use	a	custom	field,	simply	select	from	one	of	the	existing	fields	from	the	New	or	existing	field	dropdown
shown	in	the	field	configuration	form	when	adding	a	field.

Adding	conditional	rules
Note:	This	feature	is	available	from	version	1.1.0.
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Conditional	rules	let	you	define	dependencies	between	fields.	That	is,	you	can	have	certain	fields	shown/hidden
depending	on	the	values	of	other	fields.

To	add	conditional	rules,	click	the	Conditions	tab	in	the	popup	form	when	adding	or	editing	a	field.

Then,	toggle	the	Add	conditional	rules	switch.

Select	Show	this	field	or	Hide	this	field	from	the	first	dropdown	and	then	if	all	of	the	following	match	or	if	any	of
the	following	matches	from	the	next	dropdown.

You	can	then	add	as	many	rules	as	you	like	by	selecting	fields	that	the	current	field	depends	on	and	entering	values
that	need	to	be	matched	with	those	fields	in	order	for	the	current	field	to	be	shown	or	hidden.

For	example,	select	Categories,	is	one	of,	and	enter	1,5,10	to	the	text	field	so	that	your	field	will	be	shown/hidden	if
one	of	the	three	categories	(categories	with	ID	1,	5,	or	10)	is	selected	for	the	Categories	field	of	the	content	item	being
edited.

Use	the	Add	More	button	to	add	more	rules.	To	delete	a	rule,	hover	over	to	the	rule	that	you	wish	to	remove	and	click
the	red	button	displayed.

Available	elements
There	are	by	default	3	types	of	elements	that	can	be	added	to	build	the	form:	Field,	Content,	and	Utility	element
types.

Below	are	the	default	elements	available	for	each	element	type.

Field

Field	elements	add	fields	to	the	form	for	accepting	various	type	of	inputs.

Choice	-	A	multi-purpose	field	which	lets	you	choose	values	from	one	or	more	options.	It	can	be	rendered	as	a
select	list,	radio	buttons,	or	checkboxes.

Date	-	Lets	you	enter	date	and	time	(optional)	values	via	an	intuitive	user	interface.

Email	-	Lets	you	enter	e-mail	addresses.	Optionally	lets	you	enable	MX	record	checks	to	ensure	the	e-mail
addresses	exist.
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File	-	Enables	uploading	various	type	of	files	to	be	attached	to	the	content	item.	Uploads	can	be	restricted	by	file
extension	and/or	size.

Image	-	Enables	uploading	image	files	to	be	displayed	with	the	content	item.	Uploads	can	be	restricted	by	file
size.

Location	-	Lets	you	select	a	location	on	a	map	and	enter	address	details	for	the	location.

Number	-	Lets	you	enter	numeric	values	either	through	a	text	or	slider	field.

ON/OFF	-	Renders	a	checkbox	field.

Paragraph	Text	-	Lets	you	enter	multi-line	text	values.	It	can	be	rendered	as	a	plain	textarea	or	WordPress	rich
text	editor	field.

Phone	Number	-	Lets	you	enter	phone	numbers	with	an	option	to	configure	an	input	mask.

Range	-	Displays	a	slider	input	interface	to	select	a	specific	range	of	numeric	values.

Reference	-	Lets	you	select	other	content	items,	either	of	the	same	content	type	or	a	different	one,	with	auto-
suggestions.	Content	items	can	even	be	from	other	directories	as	well.

Single	Line	Text	-	Lets	you	enter	single	line	text	values	with	optional	features	such	as	input	validation	and
masking.

Social	Accounts	-	Presents	fields	to	enter	social	media	account	info.

Time	-	Shows	an	intuitive	user	interface	which	lets	you	enter	time	or	time	range	values	and/or	select	days	of
week.

URL	-	Lets	you	enter	URLs.

User	-	Lets	you	select	user	accounts	registered	on	the	site	with	auto-suggestions.

Video	-	Lets	you	add	videos	by	specifying	video	URLs	or	IDs.

Content

Content	elements	are	used	to	display	or	embed	custom	content	into	the	form.

HTML	-	Lets	you	add	a	custom	HTML	text	to	the	form.

JavaScript	-	Lets	you	embed	a	custom	JavaScript	code	into	the	form.

Text	-	Lets	you	add	custom	non-HTML	text	to	the	form.

Utility

Utility	elements	include	elements	that	can	organize	or	group	other	elements,	or	elements	that	do	not	belong	to	other
element	types.

Columns	-	Groups	multiple	elements	and	display	them	in	columns.

Group	-	Groups	multiple	elements	to	act	like	a	single	element.

Separator	-	Adds	a	horizontal	line	separator	used	to	separate	elements.

Tabs	-	Groups	multiple	elements	and	display	them	in	tabs.

reCAPTCHA	(requires	Directories	-	Frontend	plugin)	-	Displays	a	CAPTCHA	field	using	Google	reCAPTCHA	API.
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Managing	and	Customizing	Displays
Displays	define	how	individual	posts	and	taxonomy	terms	are	rendered	in	the	frontend.	The	following	is	the	list	of
displays	available	by	default.

Detailed	-	This	display	is	used	to	render	the	full	detail	of	a	content	item	when	visiting	its	permalink	URL.

Summary	-	This	display	renders	summarized	information	of	each	content	item,	usually	when	a	group	of	content
items	are	displayed.	For	example,	when	listings	are	displayed	on	the	directory	index	page	in	List	or	Masonry	view
mode.

Dashboard	Row	(requires	Directories	-	Frontend	plugin)	-	This	display	is	used	to	render	each	content	item	as	a
table	row	in	the	frontend	dashboard.

Note	that	not	all	content	types	have	all	the	displays	above	available.

Editing	a	display
Displays	can	be	edited	using	a	drag	and	drop	display	editor	in	the	backend.	We	will	explain	here	in	detail	how	you	can
customize	a	display	by	actually	editing	the	Detailed	display	for	listings.	Here	you	will	add	the	following	2	new	sections
to	the	display.

Features	-	lists	all	the	services	and	amenities	available	with	the	currently	displayed	listing.

Related	Listings	-	displays	listings	related	with	the	currently	displayed	listing	in	row	and	grid	layouts.

Editing	the	Detailed	display	for	listings

Follow	the	steps	below	to	start	editing	the	Detailed	display	for	listings.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Displays.
The	page	should	now	look	like	below	showing	a	drag	&	drop	display	editor.
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Each	grey	box	in	the	editor	is	referred	to	as	an	element	in	this	documentation.

You	can	drag	the	elements	to	wherever	you	wish	for	a	certain	content	to	appear,	configure	elements,	or	add	new
elements	to	the	display.

Adding	the	Features	section

1.	 Before	proceeding	to	the	next	step,	make	sure	first	that	you	have	created	a	custom	field	titled	Features	using	the
Choice	type	field	by	following	the	instructions	in	Adding	and	Managing	Fields	-	Adding	a	custom	field.

2.	 On	the	display	editor,	make	sure	the	Detailed	sub-tab	is	selected.	Then,	scroll	down	to	the	bottom	of	the	page
and	then	click	the	green	Add	Element	button	with	a	plus	sign	which	opens	a	popup	window.
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3.	 In	the	popup	window,	select	the	Field	tab	and	click	Features.

4.	 Under	the	General	Settings	tab,	configure	settings	as	follows.

Label	-	Default	label

Show	label	as	heading	-	Yes

Field	Renderer	-	Checklist

5.	 Leave	other	settings	as-is	and	click	the	Add	Element	button	at	the	bottom	of	the	popup	window.	This	will	add	a
Features	field	element	to	the	display	as	below.

Adding	the	Related	Listings	section

We	will	first	add	a	new	custom	field	to	listings	so	that	listing	authors	or	administrators	can	select	related	listings	when
adding/editing	a	listing.	Follow	the	steps	below	to	add	such	field.

1.	 Click	the	Manage	Fields	tab.

2.	 Click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom	of	the	page.

3.	 In	the	popup	window,	select	the	Field	tab	and	click	Reference.

4.	 Under	the	General	Settings	tab,	configure	as	follows.

Label	-	Related	Listings

Content	Type	-	XXXX	-	Listing	(where	XXXX	is	the	label	of	your	directory)

Max	number	of	values	-	Unlimited

5.	 Press	the	Add	Element	button	at	the	bottom	of	the	popup	window.	A	new	field	labeled	Related	Listings	will	be
added	to	the	form	editor.

Try	adding	or	editing	listings	and	see	how	the	field	works.	The	field	in	the	listing	form	should	look	similar	to	below.

Managing	and	Customizing	Displays

51



The	field	has	an	auto-suggest	feature	enabled	so	that	you	will	see	auto-suggested	listings	below	the	field	while	typing
into	the	field.	Add	some	related	listings	using	the	field	so	that	they	can	be	displayed	with	the	Detailed	display.

Now,	let's	go	back	to	the	display	editor	page	of	the	Detailed	display	and	add	an	element	to	the	display	that	will	render
related	listings.

1.	 On	the	Detailed	display	editor,	click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom.

2.	 In	the	popup	window,	select	the	Content	tab	and	click	the	element	labeled	XXXX	-	Listings	(where	XXXX	is	the
label	of	your	directory)	which	has	a	description	shown	as	Referenced	as	Related	Listings.

The	element	will	display	listings	that	are	referencing	the	current	listing	as	a	related	listing.	For	example,	if	listing
A,	B,	and	C	were	selected	as	related	listings	when	adding	or	editing	listing	D,	then	the	element	will	display	listing
D	as	a	related	listing	when	viewing	listing	A,	B,	or	C.	By	default,	the	display	element	will	not	display	anything	for
listing	D.

However,	you	may	also	want	to	show	listings	A,	B,	and	C	as	related	listings	when	viewing	listing	D.	In	that	case,
select	Yes	for	the	Include	referenced	items	option	under	the	General	Settings	tab.
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3.	 Leave	other	options	as-is	and	click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

That's	all	for	editing	the	display.	Try	adding	or	editing	listings	and	see	how	the	Detailed	display	is	rendered	on	single
listing	pages	in	the	frontend.	The	Features	and	Related	Listings	sections	on	the	page	should	look	similar	to	below.
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Styling	elements
You	can	style	an	element	by	adding	a	CSS	class	to	the	element	and	then	applying	custom	CSS	rules	to	the	class.
When	adding	or	editing	an	element,	click	the	Advanced	tab	and	enter	a	custom	CSS	class	name	to	the	CSS	class
setting.	You	can	insert	multiple	CSS	class	names	by	separating	them	with	a	space.

To	add	custom	CSS	rules	to	the	class,	you	can	either	add	them	to	the	style.css	file	of	your	current	theme	or	via	the
custom	CSS	editor	available	for	each	display	which	can	be	found	under	the	display	editor.
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We	recommend	using	the	CSS	editor	since	that	allows	you	to	export	and	import	your	custom	CSS	rules	as	well	when
you	export	and	import	directory	settings.

Available	elements
There	are	by	default	3	types	of	elements	that	can	be	added	to	displays;	Field,	Content,	and	Utility	element	types.

Below	is	the	list	of	elements	available	by	default.	Note	that	some	elements	may	be	available	for	certain	content	types
only.	You	should	also	see	more	elements	available	if	you	add	custom	fields.

Field

Field	elements	render	field	values	of	the	content	item	to	display.

Author	-	Renders	a	thumbnail	image	and/or	the	username	of	the	content	author.

Opening	Hours	(Listing)	-	Renders	a	table	of	opening	hours.

Categories	(Listing)	-	Renders	a	list	of	categories	associated	with	the	listing.

Date	Established	(Listing)	-	Renders	the	established	date	entered	for	the	listing.

Description	(Category	/	Tag	/	Location)	-	Renders	the	description	of	the	taxonomy	term.

E-mail	Address	(Listing)	-	Renders	the	e-mail	address	entered	for	the	listing.

Fax	Number	(Listing)	-	Renders	the	fax	number	entered	for	the	listing.

Field	Template	-	Displays	custom	content	rendered	by	a	template	file	and	have	it	act	as	a	field.	See	Template
Files	for	more	details.

Listing	Description	(Listing)	-	Renders	the	description	entered	for	the	listing.

Location	(Listing)	-	Renders	the	location	address	of	the	listing	in	a	customizable	format.

Locations	(Listing)	-	Renders	a	list	of	location	taxonomy	terms	associated	with	the	listing.

Payment	Plan	(Listing)	-	Renders	the	name	and/or	expiration	date	of	the	payment	plan	associated	with	the
listing.
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Phone	Number	(Listing)	-	Renders	the	phone	number	entered	for	the	listing.

Photos	(Listing)	-	Renders	photos	uploaded	for	the	listing.

Price	Range	(Listing)	-	Renders	the	price	range	specified	for	the	listing.

Publish	Date	(Listing	/	Claim	/	Review)	-	Renders	the	date/time	of	the	content	published.

Rating	(Review)	-	Renders	overall	rating	score	or	rating	bars.

Review	(Review)	-	Renders	the	review	body.

Social	Accounts	(Listing)	-	Renders	links	to	social	media	pages	associated	with	the	listing,	embeds	Facebook
Page	plugin	or	Twitter	Feed.

Tags	(Listing)	-	Renders	a	list	of	tags	associated	with	the	listing.

Title	-	Renders	the	title	of	the	current	content	item	with	an	option	to	link	the	title	to	the	permalink	URL	of	the
content	item	or	to	a	URL	of	another	field.

Website	URL	(Listing)	-	Renders	a	link	to	the	URL	entered	for	a	listing.

Message	(Claim)	-	Renders	the	message	text	entered	for	the	claim.

Thumbnail	(Category)	-	Renders	the	thumbnail	image	of	the	category.

Photo	(Location)	-	Renders	the	photo	image	of	the	location.

Content

Content	elements	let	you	add	various	types	of	content	to	the	display.

Button	-	Renders	call	to	action	buttons.

Child	Terms	(Category	/	Tag	/	Location)	-	Renders	child	terms	of	the	taxonomy	term

Comments	(Listing	/	Review)	-	Renders	comments	submitted	for	the	listing.

Contact	Form	(Listing)	-	Renders	a	contact	form	for	sending	messages	to	the	listing	author.

HTML	-	Renders	a	custom	HTML	text,	with	support	for	WordPress	shortcodes.

JavaScript	-	Renders	a	custom	Javascript	code.

Labels	(Listing	/	Claim	/	Review)	-	Renders	small	tags	adding	context	to	the	listing.

Rating	Stars	(Listing)	-	Displays	rating	of	the	listing	with	interactive	star	icons.

Review	Ratings	(Listing)	-	Renders	overall	review	score	or	rating	bars	in	a	customizable	format.

Statistics	(Listing	/	Review)	-	Displays	various	statistics	of	the	content	item	with	icons	and	numbers.

Template	-	Displays	custom	content	rendered	by	a	template	file.	See	Template	Files	for	more	details.

Text	-	Renders	a	custom	non-HTML	text.

Utility

Utility	elements	let	you	organize	or	group	elements.

Columns	-	Groups	and	displays	multiple	elements	in	columns.

Field	List	-	Groups	multiple	Field	type	elements	and	renders	them	as	a	definition	list.
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Group	-	Groups	multiple	elements	to	act	like	a	single	element.

Separator	-	Adds	a	horizontal	line	to	separate	elements.

Tabs	-	Displays	multiple	elements	in	tabs.
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Adding	and	Managing	Filters
If	your	directory	is	a	property	directory,	you	may	want	users	to	be	able	to	view	property	listings	within	a	certain	price
range	only.	Or	if	it	is	a	restaurant	directory,	some	visitors	may	only	be	interested	in	finding	restaurants	that	serve	Thai
cuisine.	This	is	where	filters	come	into	play.	Filters	allow	your	site	visitors	to	limit	or	narrow	content	items	displayed
based	on	additional	criteria.	If	your	directory	contains	a	large	number	of	content	items,	then	filters	are	a	must-have	for
improving	site	usability.

Visit	the	directory	index	page	in	the	frontend	to	play	around	with	the	default	filters	already	setup	for	your	directory	by
the	system.	If	your	site	does	not	have	enough	content	to	test	the	filters,	you	can	try	it	on	our	demo	site	at

https://demo.directoriespro.com/listings-with-filters/.	Click	on	the	filter	button	 	above	the	listings	to	open	a	filter
form.	Try	clicking	on	the	checkboxes	or	changing	the	values	in	the	filter	form	and	see	how	the	listings	below	the	filters
are	updated	automatically.
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Also	notice	the	numbers	in	parentheses	for	each	option	in	the	filter	form	indicating	post	counts	are	updated
dynamically	(which	we	refer	to	as	facet	counts)	and	options	without	any	posts	are	greyed	out	depending	on	the	filters
currently	selected	as	can	be	seen	below:
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Adding	a	filter
Filters	filter	content	items	based	on	field	values.	Therefore	before	adding	a	filter,	you	must	first	choose	an	existing	field
or	create	a	new	field	to	which	to	apply	the	filter.

In	this	section	we	will	add	a	filter	to	the	Features	field	of	listings.	Make	sure	first	that	you	have	already	created	the
field	by	following	the	instructions	in	Adding	and	Managing	Fields	-	Adding	a	custom	field.
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Follow	the	steps	below	to	create	a	filter	for	the	Features	field:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Views.

5.	 Click	the	Manage	Filters	button.

This	will	navigate	you	to	the	following	page	showing	a	drag	&	drop	filter	form	editor:
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Each	box	in	the	editor	is	referred	to	as	an	element	in	this	documentation.

6.	 Click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom	of	the	page	which	will	open	a	popup	window.
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7.	 In	the	popup	window,	select	the	Field	tab	and	click	Features.

8.	 In	the	popup	window	under	the	General	tab,	configure	the	element	as	follows:

Label	-	Icon	+	Default	label

Icon	-	Select	any	icon	you	like

Show	label	as	heading	-	Yes

Match	any	or	all	-	Match	all

9.	 Leave	other	settings	as-is	and	click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

You	should	see	the	filter	element	to	the	editor	as	below:

You	can	drag	the	element	to	wherever	you	wish	the	filter	to	appear	in	the	filter	form.

And	below	is	how	the	filter	is	displayed	in	the	frontend:
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Note	that	the	filter	form	is	responsive.	That	is,	filters	are	displayed	in	3	columns	only	when	there	is	enough	space.
When	there	is	not	enough	space	to	show	the	filters	in	multiple	columns,	for	example	when	the	filter	form	is	placed	in
the	sidebar	or	when	viewing	on	a	small	screen	devices,	the	filters	are	displayed	in	a	single	column.

Deleting	a	filter
Follow	the	instructions	below	to	delete	a	filter	for	listings:

1.	 On	the	filter	form	editor,	hover	over	to	the	filter	which	you	wish	to	delete,	and	then	click	the	red	trash	icon.

2.	 Click	OK	on	the	popup	alert	box.

3.	 The	filter	will	disappear	and	is	removed	from	the	filter	form.

Disabling	facet	counts
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Facets	counts	(post	counts	that	are	updated	dynamically	depending	on	the	current	search/filter	criteria)	are	enabled
by	default.	If	you	wish	to	disable	the	feature,	go	to	Directories	->	Settings,	click	the	Filters	sub-tab	and	uncheck	the
Enable	facet	counts	option	under	the	Filter	Settings	section.
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Adding	Search
The	search	feature	lets	you	setup	a	basic	search	form	for	your	directory.

If	you	already	have	setup	filters	for	your	directory	following	the	instructions	in	Adding	and	Managing	Filters,	then	you
may	not	feel	the	need	for	setting	up	another	interface	for	finding	listings.	However	if	there	is	a	large	number	of	filters,
providing	a	basic	search	form	as	the	initial	entry	point	to	your	directory	should	greatly	help	in	improving	user
experience.	This	way,	for	example,	users	can	first	make	a	general	search	using	the	search	form	on	the	home	page
and	then	narrow	down	the	search	results	using	the	filters	on	the	directory	index	page.

Enable	search
Follow	these	steps	to	enable	search	for	your	directory:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Settings	tab,	scroll	down	the	page	and	select	Yes	for	Enable	search.

5.	 Scroll	further	down	and	click	Save	Changes.

By	default,	you	can	view	the	search	form	of	your	directory	by	appending	/search	to	the	URL	of	the	directory	index
page.	For	example	if	your	directory	index	page	is	http://example.com/directory,	the	search	form	can	be	viewed	at
http://example.com/directory/search.

Configuring	search
Follow	the	steps	below	to	configure	and	customize	the	search	form	for	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.
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5.	 Click	the	Search	sub-tab	under	the	Edit	tab.

Keyword	Search

The	keyword	search	field	lets	visitors	enter	random	keywords	that	are	then	matched	against	field	values	of
listings	in	the	directory.	By	default,	only	values	of	the	listing	title	and	description	fields	are	matched,	however
you	can	also	include	taxonomy	terms	and/or	other	custom	fields	that	support	keyword	search.

Hide	this	field	-	Whether	or	not	to	hide	the	keyword	search	field	from	the	search	form.

Min.	length	of	keywords	in	characters	-	Keywords	having	the	number	of	characters	less	than	the
number	entered	here	will	be	ignored.

Default	match	type	-	Select	Match	any	to	have	the	search	return	items	containing	one	or	more
keywords	entered,	or	Match	all	to	restrict	search	results	to	items	containing	all	keywords	entered.

Search	child	content	items	(requires	Directories	-	Reviews)	-	Whether	or	not	to	match	keywords
against	review	title	and	content.

Search	taxonomy	term	names	-	Whether	or	not	to	match	keywords	against	category/tag/location	term
names.

Extra	fields	to	include	in	search	-	Select	custom	fields	that	should	be	included	in	keyword	search.

Note:	Only	the	fields	with	field	types	that	support	keyword	search	(Single	Line	Text,	Paragraph	Text,
Number,	and	Choice	field	types	by	default)	are	listed	as	options	for	this	setting.

AUTO-SUGGEST	SETTINGS

Enable	auto	suggestions	-	Whether	or	not	to	display	suggestions	(listings,	categories,	tags,	and/or
locations)	while	typing	into	the	keyword	field.

FORM	FIELD	SETTINGS

Field	icon	-	Select	an	icon	to	be	displayed	in	the	keyword	search	field.

Placeholder	text	-	Default	text	to	be	displayed	in	the	keyword	search	field	when	there	are	no
keywords	entered.
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Display	order	-	Display	order	of	the	keyword	search	field	in	the	search	form.

Location	Search

The	location	search	field	lets	users	enter	arbitrary	text	containing	location	information,	such	as	a	street
address,	a	zip/postal	code,	a	province	name,	etc.	The	field	will	use	the	geocoding	API	in	the	background	for
one	or	more	latitude/longitude	coordinates	based	on	the	location	information	entered,	which	are	then	used	to
match	against	location	data	of	each	listing	in	the	directory.

Note:	Make	sure	that	a	valid	geocoding	provider	is	configured	in	the	Map	settings	(see	Configure	Map
Libraries).

Hide	this	field	-	Whether	or	not	to	hide	the	location	search	field	from	the	search	form.

Default	search	radius	-	Limit	listings	in	the	search	results	to	those	within	a	certain	search	radius	from
the	location	entered	in	the	location	search	field.	Select	Auto	(recommended)	to	let	the	geocoding	API
calculate	the	optimal	search	radius.

Note:	The	reason	Auto	is	recommended	for	this	setting	is	that	for	example	if	a	user	enters	a	street
name,	you	do	not	want	the	search	radius	100km	to	be	applied	to	the	search	since	the	user	is	most	likely
looking	for	listings	in	that	street	only	and	the	user	should	certainly	has	no	interest	in	listings	100km	away
from	that	street.	If	the	default	search	radius	is	set	to	Auto,	the	geocoding	API	will	take	care	of	such	issue
and	determine	the	optimal	search	radius	based	on	the	value	entered	in	the	location	search	field.

Enable	search	by	user's	current	location	-	Whether	or	not	to	display	the	My	current	location	option	in
the	field.	When	the	option	is	clicked,	the	system	will	try	to	locate	the	current	address	of	the	user	and
enter	the	address	into	the	field	if	a	valid	address	was	fetched	successfully.

Note:	This	setting	is	ignored	if	your	site	is	not	able	to	send/receive	user	data	under	the	secure	context
(HTTPS)	due	to	browser	security	restrictions.

AUTO-SUGGEST	SETTINGS

Autosuggest	terms	-	Whether	or	not	to	auto-suggest	location	taxonomy	terms.
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Depth	of	term	hierarchy	tree	(0	for	unlimited)	-	Specify	the	maximum	depth	of	the	location
hierarchy	from	which	auto-suggested	location	terms	will	be	fetched.	Enter	0	for	unlimited	depth.

Hide	if	no	posts	-	Whether	or	not	to	hide	location	taxonomy	terms	without	any	posts	from	the	auto-
suggest	list.

Hide	post	counts	-	Whether	or	not	to	hide	post	count	numbers	of	auto-suggested	location
taxonomy	terms.

Include	parent	term	paths	in	term	title	-	Whether	or	not	to	display	the	hierarchy	path	of	parent
location	terms	(e.g.,	U.S.A.	->	New	York	->	Albany)	for	each	auto-suggested	location	term.

FORM	FIELD	SETTINGS

Field	icon	-	Select	an	icon	to	be	displayed	in	the	location	search	field.

Placeholder	text	-	Default	text	to	be	displayed	in	the	location	search	field	when	there	is	no	text
entered	in	the	field.

Display	order	-	Display	order	of	the	location	search	field	in	the	search	form.

Location	Selection	Search

The	location	selection	search	field	lets	users	select	a	location	taxonomy	term	from	a	dropdown.	Use	this	field
instead	of	the	Location	Search	field	if	you	do	not	wish	to	have	visitors	enter	random	address	but	let	them
simply	select	one	of	the	pre-defined	location	taxonomy	terms	in	your	directory.

Hide	this	field	-	Whether	or	not	to	hide	the	location	selection	search	field	from	the	search	form.

Depth	of	term	hierarchy	tree	(0	for	unlimited)	-	Specify	the	maximum	depth	of	the	location	hierarchy
from	which	location	terms	will	be	fetched	and	displayed	in	the	dropdown.	Enter	0	for	unlimited	depth.

Hide	empty	terms	-	Whether	or	not	to	hide	location	taxonomy	terms	without	any	posts.

Hide	post	counts	-	Whether	or	not	to	hide	post	count	numbers	of	location	taxonomy	terms.
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FORM	FIELD	SETTINGS

Display	order	-	Display	order	of	the	location	select	search	field	in	the	search	form.
Category	Selection	Search

The	category	selection	search	field	lets	users	select	a	category	taxonomy	term	from	a	select	dropdown.

Hide	this	field	-	Whether	or	not	to	hide	the	category	selection	search	field	from	the	search	form.

Depth	of	term	hierarchy	tree	(0	for	unlimited)	-	Specify	the	maximum	depth	of	the	category	hierarchy
from	which	category	terms	will	be	fetched	and	displayed	in	the	dropdown.	Enter	0	for	unlimited	depth.

Hide	empty	terms	-	Whether	or	not	to	hide	category	taxonomy	terms	without	any	posts.

Hide	post	counts	-	Whether	or	not	to	hide	post	count	numbers	of	category	taxonomy	terms.

FORM	FIELD	SETTINGS

Display	order	-	Display	order	of	the	category	selection	search	field	in	the	search	form.
6.	 Click	Save	Changes	to	save	the	settings.

Search	form	shortcode
The	search	form	can	also	be	displayed	using	the		[drts-directory-search]		shortcode.	By	using	the	shortcode	you	can
embed	the	search	form	to	another	WordPress	page,	a	theme	template	file,	or	even	in	a	sidebar	widget.

The	following	is	the	list	of	parameters	available	with	the	shortcode:

directory	(required)	-	Machine	name	of	the	directory	the	search	form	is	for.

btn_text	-	Specify	a	custom	text	used	for	the	search	form	button	label,	defaults	to	none.

btn_icon	-	Specify	the	name	of	a	FontAwesome	icon	used	for	the	search	form	button,	defaults	to	fas	fa-search.

btn_color	-	Specify	the	name	of	color	scheme	used	for	the	search	form,	one	of	primary,	secondary,	success,
warning,	danger,	info,	dark,	light,	defaults	to	primary.
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size	-	Size	of	the	search	form,	either	lg	for	large	sized	form	or	none,	defaults	to	none.

style	-	Custom	CSS	styles	applied	to	the	search	form,	added	as	the	style	attribute	to	the	<form>	tag.

fields	-	Specify	the	fields	to	be	displayed	in	the	search	form,	using	field	names	separated	by	a	comma.	This	will
override	the	Hide	this	field	setting	of	each	field.	Valid	field	names	are	keyword,	location_address,
term_location_location,	term_directory_category.

Example:

[drts-directory-search	directory="my_directory"]

The	following	is	some	sample	output	of	the	shortcode:
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Adding	Widgets
There	are	several	widgets	in	Directories	Pro	that	can	be	displayed	in	your	theme’s	widget	areas,	including	sidebars,
footers,	headers	and	the	homepage.

Available	widgets
Directories:	Directory	-	Listings	-	Displays	a	list	of	listings	in	a	specific	order	and	configuration.

Directories:	Directory	-	Categories	-	Displays	a	list	of	categories	in	the	directory	with	thumbnail	images.

Directories:	Directory	-	Locations	-	Displays	a	list	of	locations	in	the	directory.

Directories:	Directory	-	Related	Listings	-	Displays	a	list	of	listings	related	with	the	current	listing	displayed,	in	a
specific	order	and	configuration.

Directories:	Filter	Form	-	Displays	a	filter	form	configured	for	listings.	See	Adding	and	Managing	Filters	for
details	on	filters.

Directories:	Display	Element	-	Displays	one	of	the	display	elements	enabled	for	the	Detailed	display	of	a
content	type.	See	Managing	and	Customizing	Displays	for	details	on	displays.

Highlighted	widgets

Directories:	Directory	-	Listings
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The	Directories:	Directory	-	Listings	widget	allows	you	to	display	a	list	of	listings	by	custom	criteria	in	a	specific
order.

For	example,	to	show	the	latest	listings	in	your	directory	with	thumbnails,	select	Newest	First	for	Sort	by	and	check
the	Show	thumbnail	option.

To	show	10	random	featured	listings,	enter	10	for	the	Number	of	items	to	show	(0	for	unlimited)	option,	select
Random	for	Sort	by	and	check	the	Show	featured	items	only	checkbox.

Directories:	Filter	Form

Filters	can	be	displayed	in	a	widget	using	the	Directories:	Filter	Form	widget.

Note:	The	widget	is	displayed	on	the	directory	index	and	single	taxonomy	term	pages	only,	and	the	filters	in	the
widget	are	always	displayed	in	a	single-column	layout.

Once	you	have	enabled	the	widget,	make	sure	that	filters	are	disabled	on	the	directory	index	and	single	taxonomy
term	pages	of	the	directory	to	avoid	a	conflict	with	the	filters	in	the	widget.	In	order	to	do	so	you	will	need	to	edit	the
default	view	configured	for	listings.

1.	 Click	Directories	in	the	admin	sidebar.

2.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

3.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Views.

4.	 Click	the	gear	icon	in	the	row	of	the	default	view.
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5.	 Scroll	down	to	FILTER	SETTINGS	under	the	View	Mode	Settings	section.

6.	 Select	No	for	the	Show	filter	form	option.

7.	 Scroll	down	the	page	and	press	Save	Changes.

Directories:	Display	Element

The	Directories:	Display	Element	widget	is	different	from	other	widgets	in	that	the	widget	is	displayed	only	on	single
content	item	pages,	such	as	single	listing,	single	category,	single	location	pages.	The	purpose	of	the	widget	is	to
move	or	copy	a	certain	part	of	the	currently	displayed	content	item	from	the	main	content	section	of	the	page	to	where
the	widget	is	displayed.

For	example,	you	may	want	to	show	the	map	of	the	currently	displayed	listing	in	the	sidebar.	Here	are	the	steps:

Before	adding	the	widget,	you	will	need	to	first	add	a	map	to	the	single	listing	page	and	make	it	accessible	by	the
widget.

1.	 Click	Directories	in	the	admin	sidebar.

2.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

3.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Displays.

4.	 Click	the	Detailed	sub-tab.

5.	 Scroll	down	the	page	and	click	the	green	Add	Element	button	with	a	plus	icon	at	the	bottom	of	the	page	which
will	open	a	popup	window.

6.	 In	the	popup	window,	click	the	Fields	tab	and	then	click	the	Location	element.

7.	 In	the	General	tab,	select	Map	Renderer	for	the	Field	Renderer	setting	and	leave	other	settings	as-is.
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8.	 Click	the	Visibility	tab.

Select	Yes	for	Add	rendered	content	to	global	scope	which	will	allow	the	Display	Element	widget	to	access	the
content	rendered	by	this	element.

Optionally,	select	Yes	for	Remove	rendered	content	from	display	so	that	the	content	rendered	by	this	element
is	removed	from	the	main	content	section	of	the	single	listing	page.
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9.	 Click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

Now,	let's	add	a	Directories:	Display	Element	widget:

1.	 Go	to	Appearance	->	Widgets	and	click	the	Directories:	Display	Element	widget	and	press	Add	Widget.

2.	 Enter	Map	for	Title	and	select	Directory	-	Listing	-	Location	for	Select	display	element,	which	is	the	element
we've	added	to	the	Detailed	display	of	listings.

3.	 Click	Save.

Visit	the	single	listing	page	of	a	listing	in	the	frontend,	and	you	will	see	the	map	of	the	listing	displayed	in	the	sidebar
(or	wherever	you	placed	the	widget)	instead	of	in	the	main	content	section	of	the	page	as	shown	below:
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Frontend	Submit	and	Dashboard
The	Directories	-	Frontend	plugin	allows	users	to	submit	and	manage	their	content	from	the	frontend	without	going	to
the	backend	dashboard.

If	you	have	not	yet	installed	and	activated	the	Directories	-Frontend	plugin,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Plugins	->	Add	New	from	the	side	menu.

3.	 Click	the	Upload	Plugin	link	at	the	top	of	the	page.

4.	 Click	Browse...	and	then	locate	the	directories-frontend-x.x.x.zip	(where	x.x.x	represents	the	version	number)
file	saved	on	your	computer.	If	you	do	not	have	the	file,	you	can	download	the	package	from
https://codecanyon.net/downloads.

5.	 Click	the	Install	Now	button.

6.	 Wait	until	the	page	refreshes,	and	then	click	the	Activate	Plugin	link.
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Setting	Up	Frontend	Submission	and	Dashboard
Pages

Accepting	frontend	submission
In	order	to	let	users	submit	listings	from	the	frontend,	make	sure	first	that	a	valid	WordPress	page	is	assigned	as	the
page	for	displaying	the	listing	submission	form.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Pages	sub-tab.

4.	 Make	sure	a	valid	page	is	selected	for	XXXX	-	Add	Listing	(where	XXXX	is	the	name	of	your	directory).

5.	 Scroll	down	the	page	and	press	Save	Changes.

When	you	visit	the	page	in	the	frontend,	it	should	look	like	below:

Setting	Up	Frontend	Submission	and	Dashboard	Pages

78



Setting	Up	Frontend	Submission	and	Dashboard	Pages

79



As	with	backend	submission,	the	Create	Listings	permission	is	required	to	add	listings	through	the	frontend
submission	form	(See	Permissions	for	details	on	permissions).	If	a	user	without	the	permission	tries	to	view	the	page,
the	user	will	be	redirected	to	the	directory	index	page	if	the	user	is	a	registered	user	or	prompted	to	either	login	or
register	if	the	user	is	a	guest	user.

Once	a	listing	is	submitted	successfully	through	the	form,	the	post	status	of	the	listing	becomes	Published	if	the	user
submitted	the	listing	has	the	Publish	Listings	permission.	If	the	user	does	not	have	the	Publish	Listings	permission,
then	the	post	status	of	the	listing	is	set	to	Pending	and	requires	manual	update	of	the	post	status	from	the	backend
dashboard	by	the	administrator	in	order	for	the	listing	to	be	published	in	the	frontend.

Setting	up	frontend	dashboard
Frontend	dashboard	lets	users	manage	their	content	from	the	frontend	side	of	your	site.	In	order	to	enable	it,	make
sure	that	a	valid	WordPress	page	is	assigned	as	the	page	for	displaying	the	frontend	dashboard.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Pages	sub-tab.

4.	 Make	sure	a	valid	page	is	selected	for	Frontend	Dashboard.

5.	 Scroll	down	the	page	and	press	Save	Changes.

When	you	visit	the	page	in	the	frontend,	it	should	look	like	below:
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You	can	also	configure	which	dashboard	panels	should	be	displayed	in	the	dashboard,	as	well	as	their	labels	and
display	order.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Dashboard	sub-tab	and	scroll	down	to	Dashboard	Settings.

Select	or	de-select	options	to	enable/disable	panels.	You	can	also	edit	the	label	of	each	panel	and/or	drag	each
option	to	change	the	display	order.

WooCommerce	"My	account"	page	integration

If	the	Directories	-	Payments	plugin	is	activated	on	your	site	and	WooCommerce	is	selected	as	the	payment
component	(See	Monetization	for	details),	you	can	have	the	dashboard	displayed	on	the	My	accounts	page	of
WooCommerce.

Setting	Up	Frontend	Submission	and	Dashboard	Pages

81



In	order	to	do	so,	toggle	the	Show	dashboard	panels	option	under	WooCommerce	"My	account"	Page
Integration.

Then	the	WooCommerce	My	account	page	will	display	the	dashboard	fully	integrated	as	below:
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You	can	also	turn	on	the	Redirect	dashboard	access	setting	so	that	any	attempt	to	access	the	directory	dashboard
page	is	automatically	redirected	to	the	WooCommerce	"My	account"	page.	Note	that	this	will	not	work	when	you	are
using	the	[drts-dashboard]	shortcode	on	the	directory	dashboard	page.
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User	Login/Registration	and	Guest	Posts

User	Login/Registration	Settings
Guest	users	are	redirected	to	the	default	WordPress	login	page	when	they	try	to	submit	listings	from	the	frontend
(unless	guest	posting	is	enabled,	see	Guest	Post	Settings).	However,	the	design	and	layout	of	the	default	WordPress
login	page	does	not	match	your	current	theme	which	may	be	confusing	to	some	visitors.

This	is	when	you	can	enable	the	custom	login/registration	form	feature.	When	enabled,	login	and	registration	forms
are	displayed	on	a	standard	WordPress	page	using	the	layout	of	your	WordPress	theme.

Below	is	an	example	of	how	the	login/registration	page	looks	like	when	the	feature	is	enabled:

Follow	the	steps	below	to	enable	and	configure	custom	user	login/registration	forms:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Frontend	Submit	sub-tab	and	scroll	down	to	the	section	labelled	User
Login/Registration	Settings:

Show	user	login	form	-	Whether	or	not	to	show	a	custom	login	form	to	guest	users.

Show	user	registration	form	-	Whether	or	not	to	show	a	custom	registration	form	to	guest	users.
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Note:	Make	sure	user	registration	is	enabled	in	WordPress	(Settings	->	General	->	Membership),	otherwise
the	registration	form	will	not	display	even	when	Yes	is	selected	for	this	option.

Add	reCAPTCHA	field	(requires	reCAPTCHA	add-on)	-	Whether	or	not	to	add	a	CAPTCHA	field	to	the	login
and	registration	forms	for	spam	prevention.	For	more	details	on	reCAPTCHA,	see	Preventing	Spam	with
reCAPTCHA.

Here	is	how	the	forms	look	like	when	the	reCAPTCHA	field	is	enabled:

4.	 Scroll	down	the	page	and	press	Save	Changes.

In	addition,	make	sure	that	a	valid	WordPress	page	is	assigned	as	the	page	for	displaying	the	login	and	registration
forms.

1.	 Click	the	Pages	sub-tab	and	scroll	down	to	Page	Settings.

2.	 Make	sure	a	valid	page	is	selected	for	Login/Registration.

3.	 Scroll	down	the	page	and	press	Save	Changes.

Guest	Post	Settings
In	Directories	Pro,	you	can	let	visitors	submit	listings	to	your	directory	without	login	or	registration	by	granting	the
Create	Listings	permission	to	the	Guest	user	role	(see	Permissions	for	details).

Guest	users	are	by	default	required	to	enter	their	name	and	e-mail	address	when	posting.	There	are	additional	options
such	as	requiring	them	to	enter	a	website	URL	and	un-requiring	the	e-mail	address	field.	In	order	to	configure	what
data	should	or	should	not	be	collected	from	guest	users,	follow	these	steps:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Frontend	Submit	sub-tab	and	scroll	down	to	the	section	labelled	Guest	Post
Settings:
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Collect	e-mail	address	-	Whether	or	not	to	show	an	e-mail	address	field.

Require	e-mail	address	-	Whether	or	not	to	require	an	e-mail	address	to	be	entered.

Do	not	allow	e-mail	address	used	by	registered	users	-	Whether	or	not	to	prevent	from	entering	an	e-mail
address	that	is	associated	with	an	existing	user	account.

Check	MX	record	of	e-mail	address	-	Whether	or	not	to	make	sure	a	valid	MX	record	is	found	for	the
domain	of	the	e-mail	address	entered,	to	prevent	fake	e-mail	addresses.

Collect	website	URL	-	Whether	or	not	to	show	a	website	URL	field.

Require	website	URL	-	Whether	or	not	to	require	a	website	URL	to	be	entered.

4.	 Scroll	down	the	page	and	press	Save	Changes.

In	the	frontend,	a	form	similar	to	below	will	be	shown	to	guest	users	when	they	try	to	submit	a	listing:
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The	guest	user	can	then	fill	out	the	fields	and	click	the	Continue	button	to	proceed	to	the	add	listing	page.

User	Login/Registration	and	Guest	Posts

87



Preventing	Spam	with	reCAPTCHA
reCAPTCHA	is	a	free	service	provided	by	Google	which	lets	you	embed	a	CAPTCHA	field	to	forms	on	your	site	to
stop	posts	submitted	by	robots	or	abusive	scripts.

Setting	up	reCAPTCHA
Follow	the	instructions	below	to	setup	reCAPTCHA:

1.	 Generate	Google	reCAPTCHA	API	keys	for	your	site.	Make	sure	to	select	reCAPTCHA	V2	as	the	type	of
reCAPTCHA	when	registering	your	site.

2.	 Go	to	the	WordPress	administration	dashboard	and	click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab,	then	the	reCAPTCHA	sub-tab	and	configure	the	following:

reCAPTCHA	API	site/secret	key	-	Enter	the	API	keys	generated	on	Google	in	step	1.

reCAPTCHA	theme	-	Select	the	color	theme	of	the	CAPTCHA	field.

Light:

Dark:

reCAPTCHA	type	-	Select	the	type	of	CAPTCHA	to	serve.	Note	that	the	challenge	popup	is	displayed	only
when	the	user	stays	on	the	page	for	more	than	5	minutes.
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Image:

Audio:
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reCAPTCHA	size	-	Select	the	display	size	of	the	CAPTCHA	field.

Normal:

Compact:

4.	 Scroll	down	the	page	and	press	Save	Changes.

Adding	reCAPTCHA	to	forms
Follow	the	steps	below	to	add	reCAPTCHA	to	the	listing	submission	form	on	the	add	listing	page.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Fields.

5.	 Click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom	of	the	page.
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6.	 In	the	popup	window,	click	the	Utility	tab,	hover	over	to	the	reCAPTCHA	element	and	click.

7.	 Leave	the	settings	as-is,	and	press	the	Add	Element	button	at	the	bottom	of	the	popup	window	to	add	the
reCAPTCHA	element.

reCAPTCHA	can	also	be	added	to	the	claim	listing	form	and	the	review	submission	form	by	repeating	the	same	steps
above	for	Claim	or	Review	instead	of	Listing.

If	custom	login/registration	forms	are	enabled,	reCAPTCHA	can	also	be	added	to	those	forms.	See	User
Login/Registration	and	Guest	Posts	for	more	details.
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Monetization
The	Directories	-	Payments	plugin	lets	you	monetize	your	site	by	charging	users	for	posting	their	listings	on	your
directory	or	adding	premium	features	to	listings.	By	default,	purchase	and	payment	are	handled	by	WooCommerce,
meaning	that	all	the	features	provided	with	the	WooCommerce	plugin	become	automatically	available.

If	you	have	not	yet	installed	and	activated	the	Directories	-	Payments	plugin,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Plugins	->	Add	New	from	the	side	menu.

3.	 Click	the	Upload	Plugin	link	at	the	top	of	the	page.

4.	 Click	Browse...	and	then	locate	the	directories-payments-x.x.x.zip	(where	x.x.x	represents	the	version	number)
file	saved	on	your	computer.	If	you	do	not	have	the	file,	you	can	download	the	package	from
https://codecanyon.net/downloads.

5.	 Click	the	Install	Now	button.

6.	 Wait	until	the	page	refreshes,	and	then	click	the	Activate	Plugin	link.

Make	also	sure	that	you	have	installed	and	activated	the	WooCommerce	plugin.	If	not,	see	the	following	page	for
installation	instructions:	https://docs.woocommerce.com/document/installing-uninstalling-woocommerce/

Enable	payments	for	your	directory
Follow	these	steps	to	enable	payments	for	your	directory:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Settings	tab,	scroll	down	the	page	and	select	Yes	for	Enable	payments.

5.	 Scroll	further	down	and	click	Save	Changes.

Monetization

92

https://codecanyon.net/downloads
https://docs.woocommerce.com/document/installing-uninstalling-woocommerce/


Monetization	Options	and	Payment	Plans
The	Directories	-	Payments	plugin	provides	the	following	monetization	options	for	your	directory:

1.	 Charge	users	for	submitting	new	listings
2.	 Charge	users	for	claiming	existing	listings
3.	 Charge	users	for	renewing	or	reactivating	their	listings
4.	 Charge	users	for	upgrading	or	downgrading	their	listings
5.	 Charge	users	for	adding	extra	features	to	their	listings

Payment	plans
In	order	to	actually	charge	users,	payment	plans	need	to	be	setup	for	your	directory.	There	are	2	types	of	payment
plans	that	you	can	setup;	Base	and	Add-on	plans.

Base	plans

Base	plans	define	base	features	that	should	be	enabled	for	listings	associated	with	the	plans.	A	listing	may	not	have
multiple	base	plans	associated	at	the	same	time.	Base	plans	can	be	purchased	when	users	submit	new	listings,	claim
existing	listings,	renew	their	listings,	or	upgrade/downgrade	their	listings	(correspond	to	1-4	monetization	options
above).

Add-on	plans

Add-on	plans	provide	additional	features	to	listings	(corresponds	to	the	5th	monetization	option	above)	on	top	of	the
features	provided	with	a	base	plan.	A	listing	must	already	have	a	base	plan	associated	in	order	to	have	add-on	plans
applied.	There	is	no	limit	on	how	many	add-on	plans	can	be	purchased	for	a	single	listing.

Adding	Payment	Plans
In	WooCommerce,	everything	is	sold	as	a	product.	Therefore	payment	plans	for	Directories	Pro	also	need	to	be
defined	as	WooCommerce	products.	In	order	to	define	base	and	add-on	payment	plans	as	WooCommerce	products,
the	following	product	types	are	added	automatically	to	WooCommerce:

Directory	-	Listing	(Base	plan)
Directory	-	Listing	(Add-on	plan)

Adding	a	Base	plan

Follow	the	steps	below	to	define	a	WooCommerce	product	for	a	Base	plan:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Products	->	Add	New	from	the	side	menu.

3.	 Enter	the	name	of	your	payment	plan	into	the	text	field	where	it	says	Product	name	which	is	a	required	field.
Optionally	enter	the	description	of	your	payment	plan	into	the	textarea	field	under	the	product	name	field.

4.	 Select	the	Directory	-	Listing	(Base	plan)	product	type	option	from	the	dropdown	menu	in	the	Product	Data
panel.
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5.	 In	the	General	tab,	enter	the	Regular	price	field	and	optionally	the	Sale	Price	field	if	you	wish	to	sell	the
payment	plan	at	a	discounted	price.

6.	 In	the	Plan	Features	tab,	configure	the	features	that	will	be	enabled	for	listings	associated	with	this	base	plan.
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Plan	Duration	Settings

Duration	in	days	-	Set	the	length	of	time	in	days	the	payment	plan	is	associated	with	listings.	If	you
wish	to	use	the	prorated	discount	feature,	you	should	define	a	limited	duration.

Field	Settings

Allowed	fields	-	Select	the	fields	enabled	for	each	listing.
Taxonomy	Term	Settings

Max	number	of	categories	allowed	-	Select	the	maximum	number	of	categories	each	listing	can	be
associated	with.

Max	number	of	tags	allowed	-	Select	the	maximum	number	of	tags	each	listing	can	be	associated	with.

Location	Settings

Max	number	of	locations	allowed	-	Select	the	maximum	number	of	locations	each	listing	can	be
associated	with.

Photo	Settings

Max	number	of	photos	allowed	-	Select	the	maximum	number	of	photos	that	can	be	uploaded	for	each
listing.

Contact	Form	Settings

Enable	contact	form	-	Whether	or	not	to	let	users	send	messages	to	listing	authors	through	a	Contact
Us	form.

Contact	form	recipients	-	Select	e-mail	addresses	to	which	messages	are	sent.	If	you	have	added	E-
mail	type	custom	fields	to	listings	(See	Adding	and	Managing	Fields),	those	fields	can	also	be	selected
from	here.

7.	 Press	Publish	to	add	the	base	payment	plan	as	a	WooCommerce	product.

Adding	an	Add-on	plan

Follow	the	steps	below	to	define	a	WooCommerce	product	for	an	Add-on	plan:

1.	 Follow	the	steps	1-3	for	adding	a	Base	plan	described	above.

2.	 Select	the	Directory	-	Listing	(Add-on	plan)	product	type	from	the	dropdown	menu	in	the	Product	Data	panel.

3.	 In	the	General	tab,	enter	the	Regular	price	field	and	optionally	the	Sale	Price	field	if	you	wish	to	sell	the
payment	plan	at	a	discounted	price.

4.	 In	the	Plan	Features	tab,	select	or	enter	additional	features	that	should	be	applied	to	listings	when	this	add-on
plan	is	purchased.
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Most	of	the	features	available	by	default	are	similar	to	those	available	for	Base	plans.	Below	are	some	options
available	for	add-on	plans	only.

Featured	Content	Settings

Display	as	featured	-	Whether	or	not	to	mark	listings	as	featured.	Featured	listings	can	be	displayed
above	other	non-featured	listings	and/or	highlighted	to	make	them	stand	out	or	can	be	displayed
separately	for	example	using	custom	views.

Priority	-	When	multiple	featured	listings	are	displayed	and	sorted	by	featured	listings	first,	those	with
higher	priority	are	displayed	above	those	with	lower	priorities.

Duration	in	days	-	Enter	the	number	of	days	listings	will	be	marked	as	featured.

5.	 Press	Publish	to	add	the	add-on	payment	plan	as	a	WooCommerce	product.

Configuring	default	features
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Not	all	listings	are	assigned	a	base	plan.	For	example,	listings	submitted	when	there	were	no	base	payment	plans
available,	or	listings	submitted	by	guest	users	while	guest	checkout	was	disabled	do	not	have	any	base	plan
associated	unless	purchased	later	or	manually	associated	by	administrators.	These	listings	are	instead	applied	default
features	which	can	be	configured	by	following	these	steps:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.

5.	 Click	Payment	sub-tab	under	the	Edit	tab.

The	features	configurable	in	this	section	are	exactly	the	same	as	those	configurable	for	base	payment	plans	(See
Adding	a	Base	plan	above	for	details	on	each	setting).

6.	 Scroll	further	down	the	page	and	press	Save	Changes.
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Purchasing	Payment	Plans
Although	payment	plans	are	setup	as	WooCommerce	products,	they	may	not	be	purchased	through	the
WooCommerce	shop	page.	Instead,	the	purchasing	process	is	integrated	with	the	listing	submission	process.

Purchasing	a	base	plan
Let's	first	try	purchasing	a	base	plan	from	the	frontend	and	see	how	it	works.	Make	sure	that	you	have	already	created
at	least	one	base	plan	following	the	instructions	in	Adding	Payment	Plans.

1.	 Make	sure	that	you	are	already	logged	in	to	WordPress,	and	then	go	to	the	Add	Listing	page	in	the	frontend.
You	should	be	presented	with	a	select	payment	plan	form	in	the	first	step	as	below:

Choose	a	payment	plan	from	the	list	and	press	Next.

2.	 Enter	listing	details	into	the	listing	submission	form.	Scroll	down	the	page	and	you	will	see	the	label	of	the	submit
button	now	shown	as	Add	to	cart.	Press	the	Add	Cart	button.

If	there	are	no	errors,	a	new	listing	is	created	with	its	post	status	set	to	Draft	as	soon	as	the	Add	to	cart	button	is
pressed.

3.	 You	are	redirected	to	the	WooCommerce	shopping	cart	page.	The	process	from	here	on	is	exactly	the	same	as
that	of	when	purchasing	other	products	in	WooCommerce.	Press	the	Proceed	to	Checkout	button.

4.	 Fill	out	the	Billing	Details	section	and	then	press	Place	Order.

As	soon	as	the	Place	Order	button	is	pressed,	the	post	status	of	the	listing	is	updated	to	Pending.

5.	 An	order	is	created	in	WooCommerce.

When	the	payment	for	the	order	is	complete,	the	status	of	the	order	is	updated	to	Completed	either	automatically	by
WooCommerce	or	manually	by	the	administrator	depending	on	the	payment	gateway	selected	during	checkout.

Once	the	status	of	the	order	is	updated	to	Completed,	the	post	status	of	the	listing	becomes	Published	if	the	author
of	the	listing	has	the	Publish	Listings	permission.	If	the	author	of	the	listing	does	not	have	the	Publish	Listings
permission,	then	the	post	status	of	the	listing	remains	Pending	and	requires	manual	update	of	the	post	status	by	the
administrator	in	order	for	the	listing	to	be	published	in	the	frontend.	For	more	details	on	permissions,	see	Permissions.

Renewing	plan
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Once	the	duration	of	the	currently	associated	base	plan	for	a	listing	expires,	the	author	of	the	listing	is	given	a	certain
amount	of	time	for	renewal	(renewal	grace	period)	which	is	30	days	by	default.	The	listing	author	can	either	purchase
the	same	base	plan	purchased	previously	for	the	listing	or	a	different	base	plan	by	following	these	steps:

1.	 Go	to	the	Frontend	Dashboard	page	in	the	frontend.

2.	 Click	the	Listings	link	in	the	side	panel.

3.	 Click	the	Status:	All	dropdown	button	and	select	Expired.

4.	 Go	to	the	row	of	the	listing	you	wish	to	renew,	click	the	dropdown	button	with	a	gear	icon	and	then	select	Renew.

5.	 Choose	a	plan	in	the	select	plan	form	and	proceed	to	checkout.

Deactivated	listings

If	the	author	of	a	listing	fails	to	renew	the	listing	within	the	renewal	grace	period,	the	post	status	of	the	listing	is
changed	to	Draft	and	the	listing	becomes	hidden	from	the	frontend.	In	addition,	the	listing	is	marked	as	deactivated.
Deactivated	listings	can	still	be	re-activated	by	submitting	them	again	from	the	frontend	dashboard	however	an
additional	re-activation	fee	may	be	imposed.	The	listings,	when	submitted,	must	also	go	through	the	same	moderation
process	as	new	listings.

Switching	plan

Listings	with	a	valid	base	plan	that	are	currently	published	can	be	switched	to	another	base	plan	at	any	time	from	the
frontend	dashboard	page.

1.	 Go	to	the	Frontend	Dashboard	page	in	the	frontend.

2.	 Click	the	Listings	link	in	the	side	panel.
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3.	 Click	the	Status:	All	dropdown	button	and	select	Published.

4.	 Go	to	the	row	of	the	listing	you	wish	to	switch	plan	for	and	click	the	gear	icon	dropdown	button	and	then	select
Upgrade	/	Downgrade.

5.	 Choose	a	plan	in	the	select	plan	form	and	proceed	to	checkout.

Prorated	discount

When	switching	to	another	base	plan,	if	the	current	base	plan	had	a	certain	duration	configured	at	the	time	of
purchase,	then	the	plan	purchase	fee	already	paid	for	the	remaining	period	of	time	will	be	deducted	from	the	total
amount	of	purchasing	the	new	base	plan	(prorated	discount).	However,	if	no	duration	was	configured	for	the	current
base	plan	then	there	will	be	no	deduction.

Guest	purchases

Guest	users	can	purchase	base	plans	if	the	Guest	user	role	has	the	Create	Listings	permission	(see	Permissions	for
details	on	permissions)	and	also	if	the	Allow	customers	to	place	orders	without	an	account	option	is	enabled	in
WooCommerce	(WooCommerce	->	Settings	->	Accounts	and	Privacy	->	Guest	checkout).	If	not,	guest	users	will
go	through	the	normal	submission	process	and	their	listings	will	have	no	base	plans	assigned	(default	features	will	be
applied).

Purchasing	add-on	plans
Add-on	plans	can	be	purchased	by	selecting	the	Order	Add-on	link	in	the	dropdown	button	displayed	for	each	listing
on	the	frontend	dashboard	page.	The	checkout	and	payment	process	is	exactly	the	same	as	ordering	base	plans.

Note	that	listings	must	currently	be	published	and	also	has	a	valid	base	plan	associated	in	order	to	purchase	add-on
plans.

Configure	payment	settings
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Follow	the	steps	below	to	configure	payment	settings	available:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Payment	sub-tab.

Plan	Selection	Settings

Add	"No	payment	plan"	option	-	Whether	or	not	to	add	a	"No	payment	plan"	option	to	the	payment
plan	selection	form.	When	the	user	select	this	option,	the	user	will	go	through	the	normal	submission
process	and	the	listing	submitted	will	have	no	base	plan	assigned	(default	features	will	be	applied).

Plan	Renewal	Settings	-	Lets	you	configure	options	related	with	base	plan	renewals.

Renewal	grace	period	in	days	-	Specify	the	number	of	days	listing	authors	are	allowed	to	renew	their
listings	after	expiration.

Re-activation	fee	-	Enter	the	amount	of	fee	to	charge	listing	authors	for	re-activating	their	deactivated
listings.

Plan	Upgrade/Downgrade	Settings	-	Lets	you	configure	options	related	with	switching	base	plans.

Switch	plan	fee	-	Enter	the	amount	of	fee	to	charge	listing	authors	for	upgrading/downgrading	the
current	base	plan.

Enable	prorated	discount	-	Whether	or	not	to	deduct	the	fee	paid	for	the	remaining	period	of	the
current	base	plan	from	the	total	amount	of	purchasing	a	new	base	plan.

4.	 Scroll	down	the	page	and	click	Save	Changes.

Additional	notes
If	there	is	one	or	more	active	pending	orders	for	a	listing,	then	no	further	orders	can	be	made	for	the	listing.

When	a	plan	is	purchased	for	a	listing	in	a	multilingual-enabled	directory	(see	Multilingual	Directory),	the	features
provided	by	the	purchased	plan	are	applied	automatically	to	all	other	translations	of	the	listing.
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Managing	Orders
Orders	are	created	in	WooCommerce	when	a	customer	completes	the	checkout	process.	For	more	details	on	orders
in	WooCommerce,	see	https://docs.woocommerce.com/document/managing-orders/.

Viewing	orders
There	are	2	ways	to	view	orders	in	Directories	Pro.

Frontend	dashboard

Registered	users	can	view	their	orders	on	the	frontend	dashboard	page	by	following	these	steps:

1.	 Go	to	the	Frontend	Dashboard	page	in	the	frontend.

2.	 Click	Payment	->	Order	History	link	in	the	side	panel.

Details	of	each	order	can	be	viewed	by	clicking	the	Order	ID.
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Orders	metabox	in	the	backend

When	editing	a	listing	in	the	backend	dashboard,	a	metabox	labeled	Orders	can	be	found	which	contains	a	list	of
all	orders	for	the	listing.

Clicking	the	order	ID	will	take	you	to	the	order	detail	page	of	WooCommerce	in	the	backend.

Order	refunds,	fails	and	cancellations
When	the	status	of	an	order	for	a	listing	is	updated	to	Refunded,	Failed,	or	Cancelled	in	WooCommerce,	all	the
features	currently	applied	to	the	listing	are	unapplied	if	the	order	is	for	a	Base	plan.	In	addition,	the	post	status	of	the
listing	is	reverted	back	to	the	previous	status	that	was	set	before	the	order	was	marked	as	Completed.	The	payment
plan	currently	assigned	is	also	unassigned	and	reverted	back	to	the	previous	payment	plan	if	there	was	any.	If	there
was	no	previous	payment	plan,	then	the	listing	will	have	no	payment	plan	associated	and	default	features	will	be
applied.

If	the	order	is	for	an	Add-on	plan,	the	features	that	have	been	applied	to	the	listing	with	the	add-on	plan	are	fully
unapplied.
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Creating	Pricing	Tables
Pricing	tables	are	great	for	showcasing	your	products	to	visitors.	Follow	the	steps	below	to	create	a	pricing	table	that
displays	payment	plans	along	with	their	features	that	you	have	setup	for	your	directory.

[drts-directory-payment-pricing]	shortcode
The		[drts-directory-payment-pricing]		shortcode	can	be	used	to	display	a	pricing	table	for	your	directory.	The
following	is	the	list	of	parameters	available	with	the	shortcode:

directory	(required)	-	Specify	the	machine-readable	name	of	the	directory	for	which	to	show	the	pricing	table.

layout	-	Specify	the	layout	of	the	pricing	table,	group	(default)	or	deck.

color	-	Specify	the	name	of	color	scheme	used	for	the	pricing	table,	one	of	primary,	secondary,	success,	warning,
danger,	info,	dark,	light,	defaults	to	primary.

btn_text	-	Specify	a	custom	text	used	for	button	labels,	defaults	to	Choose	Plan.

cache	-	Whether	or	not	to	cache	the	output	of	the	pricing	table,	0	or	1,	defaults	to	0	(no	cache).

plans	-	IDs	of	base	payment	plans	to	display	separated	with	a	comma.	All	base	plans	will	be	displayed	if	none
given,	defaults	to	none.

add_no_payment_plan	-	Whether	or	not	to	add	no	payment	plan	option	to	the	pricing	table,	0	to	prepend	or	1	to
append.	Requires	Add	"No	payment	plan"	option	setting	switched	on	under	Directories	->	Settings	->
Payment	->	Plan	Selection	Settings.

no_payment_plan_title	-	Set	the	payment	plan	title	displayed	for	the	no	payment	plan	option.

no_payment_plan_desc	-	Set	the	payment	plan	description	displayed	for	the	no	payment	plan	option.

Follow	the	steps	below	to	use	the	shortcode	and	create	a	pricing	table	page	for	your	directory:

1.	 Select	Pages	->	Add	New	from	the	side	menu.

2.	 Enter	some	content	about	your	payment	plans	and	the		[drts-directory-payment-pricing]		shortcode.

3.	 Publish	the	page	and	the	page	should	look	similar	to	below	in	the	frontend:
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WooCommerce	Subscriptions
Directories	Pro	is	compatible	with	the	WooCommerce	Subscriptions	plugin.	By	installing	and	activating	the
WooCommerce	Subscriptions	plugin,	you	can	create	subscription-based	recurring	payment	plans	(hereafter	referred
to	as	Subscription	plans)	which	are	basically	Base	payment	plans	with	automatic	billing	capability.	You	can	charge
users	for	posting	their	listings	on	a	weekly,	monthly,	or	yearly	basis.

Creating	a	Subscription	plan
Follow	the	steps	below	to	define	a	WooCommerce	product	for	a	Subscription	plan:

1.	 Make	sure	the	WooCommerce	Subscriptions	plugin	is	already	installed	and	activated.

2.	 Follow	the	steps	1-3	for	adding	a	Base	plan.

3.	 Select	the	Directory	-	Listing	(Subscription	plan)	product	type	from	the	dropdown	menu	in	the	Product	Data
panel.

If	you	do	not	see	the	subscription	payment	plan	option	in	the	dropdown,	try	clearing	the	cache	from	Directories	-
>	System	->	Tools	using	the	Clear	cache	tool.

4.	 In	the	General	tab,	enter	the	Subscription	price	field	and	optionally	the	Sale	Price	field	if	you	wish	to	sell	the
payment	plan	at	a	discounted	price.

You	can	charge	renewal	payments	using	a	billing	period	of	daily,	weekly,	monthly	or	annually,	and	at	any	interval
between	1	and	6	(inclusive).

The	Expire	after	setting	allows	you	to	end	a	subscription	after	a	predetermined	amount	of	time.	Subscription
plans	with	this	setting	set	to	Never	expire	can	renew	indefinitely	as	long	as	renewal	payments	are	successful.
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You	can	add	a	Free	trial	period	to	the	beginning	of	a	subscription.	This	period	is	added	to	any	length	you	set	for
the	subscription.	For	example,	if	you	create	a	subscription	of	$5	per	month	for	6	months	with	a	1-month	free	trial
period,	the	subscription	will	expire	after	7	months.

5.	 In	the	Plan	Features	tab,	select	or	enter	features	that	should	be	applied	to	listings	when	this	subscription	plan	is
purchased.

The	features	that	you	can	configure	here	are	exactly	the	same	as	that	of	a	Base	plan.	For	details	on	each	feature,
see	adding	a	Base	plan.

6.	 Press	Publish	to	add	the	subscription	payment	plan	as	a	WooCommerce	product.

Managing	Subscriptions
For	details	and	instructions	on	managing	subscriptions	in	the	backend,	see
https://docs.woocommerce.com/document/subscriptions/store-manager-guide/#section-11.

Users	who	purchased	subscriptions	can	view	and	manage	their	subscriptions	on	the	directory	dashboard	page	in	the
frontend.	Click	the	Subscriptions	link	under	Payments	in	the	menu	panel	to	view	all	the	subscriptions.

Click	the	ID	of	a	subscription	to	view	the	details	of	the	subscription	in	a	popup	window.
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You	can	also	cancel,	renew,	or	resubscribe	the	subscription	by	clicking	on	the	buttons	in	the	Actions	section.
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Localization	and	Multilingualization
Directories	Pro	comes	localization-ready	out	of	the	box.	There	are	several	methods	to	localize	the	user	interface	into
your	language	of	choice.	In	addition,	with	the	WPML	plugin	you	can	not	only	translate	predefined	UI	strings	but	also
user	content	and	custom	text	strings	added	to	your	directory.
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Localization

Translating	with	.po/.mo	files
Language	files	included	are	in	the	Gettext	format,	which	is	the	standard	format	used	for	language	files	in	WordPress.
Each	plugin	contains	a	.pot	(Potable	Object	Template)	file	under	the	languages	sub-folder:

Directories	-	wp-content/plugins/directories/languages/directories.pot

Directories	-	Pro	-	wp-content/plugins/directories-business/languages/directories-business.pot

Directories	-	Frontend	-	wp-content/plugins/directories-frontend/languages/directories-frontend.pot

Directories	-	Payments	-	wp-content/plugins/directories-payments/languages/directories-payments.pot

Directories	-	Reviews	-	wp-content/plugins/directories-reviews/languages/directories-reviews.pot

Translate	these	files	using	a	software	like	Poedit	(recommended)	and	save	the	generated	MO	(.mo)	files	under	wp-
content/languages/plugins.	Make	sure	that	you	append	the	lang	code	of	your	language	to	the	file	name.	For
example,	if	you	are	translating	directories.pot	into	French,	save	the	generated	MO	file	as	directories-fr_FR.mo.	If	you
are	unsure	what	lang	code	is	currently	used	on	your	site,	go	to	Directories	->	System	->	System	Info,	scroll	down	to
the	table	labelled	Wordpress	environment	and	check	the	value	displayed	for	Locale	as	shown	below:

Note:	Some	phrases	such	as	labels	used	for	fields,	displays,	and	filters	are	not	translated	unless	you	had	your
language	files	ready	before	activating	the	plugin.	This	is	because	those	phrases	can	be	edited	from	the	backend,	and
it	would	become	a	problem	if	they	are	overwritten	by	uploading	language	files.

Translating	with	the	Say	What?	plugin
Sometimes	if	you	only	need	to	translate	a	few	number	of	words	or	phrases	you	may	not	want	to	create	an	entire
translation	file.	This	is	when	the	Say	What?	plugin	can	help.

1.	 Install	and	activate	the	Say	What?	plugin.

2.	 Go	to	Tools	->	Text	Changes.

3.	 Create	a	new	Text	Change	with	the	following	settings:

Original	string	-	Enter	the	word	or	phrase	you	are	translating.

Text	domain	-	Enter	the	name	of	the	plugin	to	which	the	original	string	belongs,	e.g.	directories,	directories-
pro,	directories-payments.

Text	context	-	Leave	it	blank	which	should	work	in	most	cases.

Replacement	string	-	Enter	the	text	you	want	to	display.

4.	 Press	the	Add	button.
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Multilingual	Directory
Directories	Pro	is	compatible	with	the	WPML	plugin.	With	WPML,	you	can	have	any	directory	content	as	well	as
custom	text	strings	added	by	yourself	such	as	form	field	labels	displayed	in	multiple	languages.

Installing	the	WPML	plugin
For	detailed	instructions	on	installing	the	WPML	plugin,	visit	the	following	page:	https://wpml.org/faq/install-wpml/

Other	than	the	core	WPML	plugin	(WPML	Multilingual	CMS),	we	also	recommend	installing	the	WPML	String
Translation	plugin	for	translating	custom	text	strings.

Setting	up	a	multilingual	directory
The	first	thing	you	must	do	to	setup	a	multilingual	directory	is	to	create	frontend	pages	for	each	language	you	have
enabled	in	WPML.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Pages	->	All	Pages	from	the	side	menu.

3.	 For	all	the	pages	currently	set	up	with	Directories	Pro	(see	Directories	->	Settings	->	Pages),	create	a	copy	for
the	language	you	wish	to	enable	by	clicking	the	plus	sign	displayed	under	country	flags.

Important:	You	can	not	use	the	same	slug	for	multiple	languages.	For	example,	if	the	directory	index	page	for
English	is	directory,	you	can	not	use	that	slug	for	any	of	the	directory	pages	in	other	languages.	Unfortunately	that
will	not	work	in	Directories	Pro.

4.	 After	creating	a	copy	for	all	pages,	click	Directories	in	the	admin	sidebar,	and	go	to	Settings	->	Pages.

5.	 Using	the	language	switcher	at	the	top	of	the	page,	select	the	language	for	which	you	have	created	pages	in	step
3.

6.	 Under	the	Page	Settings	section,	assign	pages	by	selecting	pages	created	in	step	3	and	press	Save	Changes.

7.	 Repeat	steps	3-6	for	all	other	languages	you	wish	to	enable.

In	addition,	follow	the	steps	below	to	enable	translation	of	listings,	categories,	tags,	and	locations:

1.	 Select	WPML	->	Translation	Options	from	the	side	menu.
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2.	 Scroll	down	to	Custom	posts	and	select	Translate	for	Directory	-	Listings	and	press	Save.	Note	that	you	do
not	need	to	select	Directory	-Reviews	or	Directory	-	Claims.

3.	 Scroll	down	to	Custom	taxonomies	and	select	Translate	for	Directory	-	Categories,	Directory	-	Tags,	and
Directory	-	Locations	and	press	Save.

Now	you	are	ready	to	start	creating	multilingual	content	for	your	directory!	See	the	following	page	for	details	on	adding
translations	for	your	content	items	with	WPML:	https://wpml.org/documentation/translating-your-contents/creating-
translations-manually/

Translating	custom	text	strings
Custom	text	strings	such	as	field	labels	that	you	configured	in	the	backend	can	not	be	translated	with	.po/.mo
language	files	since	those	text	strings	do	not	exist	as	predefined	phrases.	However,	with	the	WPML	String	Translation
plugin,	you	can	not	only	translate	predefined	phrases	in	language	files	but	also	custom	text	strings	from	the	string
translation	page	of	the	plugin.	To	view	the	string	translation	page,	select	WPML	->	String	Translation	in	the	side
menu.

When	you	click	the	domain	dropdown	list	you	may	already	see	several	domains	with	names	starting	with	drts-
strings-.	These	domains	are	the	ones	to	which	your	custom	text	strings	are	or	will	be	registered.	If	you	do	not	see	the
domains	or	any	strings	registered,	don't	worry	since	they	will	get	registered	once	you	actually	view	or	edit	the	strings
on	backend	or	frontend	pages	of	your	directory.

Here	is	the	list	of	domains	for	custom	text	strings	in	Directories	Pro:

drts-strings-directory_directory	-	Contains	text	strings	used	for	directory	labels.

drts-strings-display_element	-	Contains	text	strings	used	for	displays	and	filters.

drts-strings-entity_bundle	-	Contains	content	type	labels	such	as	Listings,	All	Categories,	and	%s	listings.

drts-strings-entity_field	-	Contains	text	strings	used	for	form	field	labels,	descriptions,	and	options.

drts-strings-search	-	Contains	text	strings	used	for	search	form	labels	and	placeholders.

Simply	select	a	domain	from	the	dropdown	list	and	start	translating	the	strings	registered	in	the	domain	to	make	them
multilingual.
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Exporting	and	Importing	Directories
The	import/export	feature	of	Directories	Pro	lets	you	export	and	import	both	content	and	settings	of	your	directory
which	can	then	be	imported	back	or	imported	into	a	different	site.
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Exporting	and	Importing	Content

Exporting	Content	to	CSV
The	CSV	export	feature	lets	you	export	any	content	of	your	directory	to	a	CSV	file	in	just	a	few	number	of	clicks.

Follow	the	steps	below	to	export	your	directory	content	to	a	CSV	file:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	All	Listings	(or	Categories,	Tags,	Locations,	Claims,	Reviews	depending	on	the	type	of	content	to
export)	under	your	directory	menu	in	the	admin	sidebar.

3.	 Click	the	Export	button	at	the	top	of	the	page.

4.	 Select	the	fields	to	export	by	checking	the	checkboxes	and	then	press	Next.

5.	 Depending	on	the	fields	selected,	additional	options	that	need	to	be	configured	before	exporting	to	a	CSV	file	are
displayed.	For	example,	you	can	choose	whether	or	not	to	export	image	files	to	a	zip	file	if	you	have	selected	an
Image	type	field	to	export	in	the	previous	step.
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If	you	are	unsure	about	these	options,	it	is	usually	safe	to	leave	them	as-is.

6.	 Click	the	Next	button	to	proceed	to	the	final	step:

File	name	-	Enter	the	name	of	the	CSV	file	to	export.	The	file	will	be	created	under	wp-
content/uploads/drts/System/tmp	if	export	is	successful.

Limit	to	X	records	(0	for	all	records)	-	Enter	the	number	of	content	items	to	export.

Start	from	Xth	record	-	Specify	from	which	content	item	to	start	exporting.	For	example,	enter	10	to	skip	the
first	9	records	and	start	exporting	from	the	10th	records	in	the	database.
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Number	of	records	to	process	per	request	-	The	export	process	is	triggered	through	AJAX	requests.	Set
the	number	of	content	items	that	are	exported	in	each	request.	If	you	are	unsure,	leave	it	as-is.

7.	 When	you	are	ready,	click	Export	Now.

You	will	see	a	real-time	progress	of	what	is	exported	and,	if	any,	failed.

When	the	export	process	is	complete,	a	blue	Download	button	will	show	up	under	the	progress	bar	which	you	can
click	to	download	the	exported	file.

If	for	some	reason	the	download	button	does	not	appear	or	work,	you	can	also	find	the	exported	file	under	wp-
content/uploads/drts/System/tmp	if	the	export	was	successful.

Importing	Content	from	CSV
Importing	content	to	Directories	Pro	involves	creating	a	CSV	file	and	loading	the	file	data	into	your	directory	using	the
built-in	CSV	importer.

Creating	a	CSV	file

There	is	no	fixed	format	for	your	CSV	file,	since	the	columns	in	your	CSV	file	can	be	mapped	with	content	fields	during
the	import	process.	The	only	thing	that	is	required	with	your	CSV	file	is	that	the	first	row	must	contain	labels	for	each
column	in	the	subsequent	rows.

Note:	If	you	need	a	sample	CSV	file,	the	easiest	way	to	obtain	one	is	to	create	one	or	more	posts	or	taxonomy	terms
and	then	exporting	them	to	a	CSV	file.	See	Exporting	Content	to	CSV	for	details	on	exporting	CSV	files.

Here	are	some	tips	specific	to	the	type	of	content	to	import:

Category	/	Location

Associating	parent	terms

Create	a	column	that	holds	either	the	ID	or	the	slug	of	the	parent	term	to	be	associated	with.	If	the	parent
term	is	not	an	existing	term	(does	not	exist	in	the	database),	make	also	sure	to	create	a	column	that	holds
either	the	ID	or	the	slug	of	each	term	so	that	values	in	that	column	can	be	used	to	reference	parent	terms.
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Listing

Associating	taxonomy	terms

Create	a	column	that	holds	either	the	ID	or	the	slug	of	the	the	taxonomy	term	to	be	associated	with	if	the
term	is	an	existing	term.	If	the	term	is	not	an	existing	term	(does	not	exist	in	the	database),	instead	create	a
column	that	holds	the	display	title	of	the	term,	then	the	importer	will	create	a	new	taxonomy	term	in	the
database	with	the	value	of	that	column	as	the	term	title	and	associate	it	with	the	listing.

Importing	location	data

Create	a	column	that	holds	the	full	address	of	each	listing	and	map	that	column	to	the	Full	Address
component	of	the	Location	(location_address)	field.	This	will	let	the	importer	geocode	the	address	(can	be
disabled)	using	Google	Maps	API	and	retrieve	detailed	geographic	information	of	the	location	such	as
latitude	and	longitude	coordinates.	Make	sure	to	set	up	Google	Maps	API	in	order	to	use	the	geocoding
feature.

Claim

Associating	claimed	listings

Create	a	column	that	holds	either	the	ID	or	the	slug	of	the	listing	claimed.	The	listing	must	already	exist	in	the
database.

Importing	your	CSV	file

Follow	the	steps	below	to	import	your	CSV	file:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	All	Listings	(or	Categories,	Tags,	Locations,	Claims,	Reviews	depending	on	the	type	of	content	to
export)	under	your	directory	menu	in	the	admin	sidebar.

3.	 Click	the	Import	button	at	the	top	of	the	page.

CSV	File	-	Click	Choose	File	and	locate	your	CSV	file.
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Note:	Depending	on	your	server,	the	import	process	may	fail	or	stop	before	importing	all	items	if	you	have	a
very	large	CSV	file.	In	that	case,	split	the	CSV	file	into	multiple	files	and	then	upload	them.	Make	sure	that	all
the	files	have	the	same	header	columns	in	the	first	row.	The	importer	will	then	process	those	files	one	by
one.

CSV	column	delimiter	-	Enter	the	character	used	as	CSV	column	delimiters	in	your	CSV	file.	The	default
value	is	a	single	comma.

CSV	column	enclosure	-	Enter	the	character	used	as	CSV	column	enclosures	in	your	CSV	file.	The	default
value	is	a	double	quote.

4.	 Click	the	Next	button	to	go	to	the	next	step:

In	this	step,	you	will	map	the	columns	in	your	CSV	file	with	fields	that	are	defined	for	the	content	type	to	import.
For	each	column	header	in	your	CSV	file	on	the	left,	select	a	matching	field	on	the	right	to	be	associated	with.

5.	 After	associating	CSV	columns	with	content	type	fields,	click	the	Next	button	to	proceed	on	to	the	next	step:
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Some	fields	associated	with	the	columns	in	your	CSV	file	may	have	additional	options	that	can	be	configured	in
this	step.	For	example,	if	a	field	supports	importing	of	multiple	values,	there	will	be	an	option	for	the	field	to
specify	the	delimiter	character	used	to	separate	values	in	the	CSV	column.	Another	example	is	an	Image	type
field	which	lets	you	upload	a	zip	file	containing	image	files	to	be	imported	for	the	field.

If	you	are	unsure	about	these	options,	it	is	usually	safe	to	leave	them	as-is.

6.	 Click	the	Next	button	to	proceed	to	the	final	step:

Number	of	records	to	process	per	request	-	The	import	process	is	triggered	through	AJAX	requests.	Set
the	number	of	content	items	that	are	imported	in	each	request.	If	you	are	unsure,	leave	it	as-is.

7.	 When	you	are	ready,	click	Import	Now	to	import	your	CSV	file.

You	will	see	a	real-time	progress	of	what	is	imported	and,	if	any,	failed.
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Updating	existing	content

You	can	also	update	existing	content	through	CSV	import.	Simply	create	a	column	in	your	CSV	file	that	holds	existing
content	item	IDs	and	map	that	column	with	the	ID	field	of	the	content	type	when	importing.

Importing	Listings	with	WP	All	Import
Directories	Pro	includes	an	add-on	for	the	WP	All	Import	plugin	which	lets	you	easily	import	listings	from	any	CSV	or
XML	file.

To	import	listings	using	WP	All	Import,	make	sure	the	WP	All	Import	plugin	is	installed	and	activated	and	then	follow
the	steps	below	:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	All	Import	->	New	Import	in	the	admin	sidebar.

3.	 Upload	a	CSV/XML	file	or	enter	a	URL	to	download	the	file,	select	your	directory	listings	option	from	the
dropdown	and	click	Continue	to	Step2.

4.	 Configure	filtering	options	if	you	need	to	and	then	click	Continue	to	Step3.

5.	 Drag	and	drop	the	fields	from	your	CSV	or	XML	file	into	the	appropriate	corresponding	listing	fields.	After	filling
out	the	fields,	click	Continue	to	Step4.
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6.	 For	the	Unique	Identifier	option,	click	the	Auto-detect	button	if	you	are	unsure.
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7.	 If	you	are	happy	with	the	import	click	the	Confirm	and	Run	Import	button.
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Exporting	and	Importing	Settings

Exporting	settings	of	a	directory
You	can	export	settings	(including	content	type	and	permission	settings)	of	your	directory	which	can	then	later	be
imported	to	setup	a	copy	of	the	directory	without	re-configuring	the	settings.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	dropdown	button	next	to	the	gear	icon	in	the	row	of	your	directory	and
then	click	Export.

4.	 In	the	popup	form,	enter	the	file	name	of	the	JSON	file	that	will	be	exported.	Optionally	select	Yes	for	Pretty-print
JSON	to	export	readable	JSON.

5.	 Click	the	Export	button	at	the	bottom	of	the	popup	window.

A	progress	bar	will	show	up	indicating	the	current	status	of	the	export	process.

6.	 When	the	export	is	complete,	the	exported	file	will	be	downloaded	automatically	by	your	browser.	If	not,	you	can
click	the	Download	button	that	appears	at	the	bottom	of	the	popup	window	to	manually	download	the	exported
file.
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Importing	settings	of	a	directory
You	can	create	a	new	directory	by	importing	settings	of	a	directory	that	have	previously	been	exported.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Add	Directory	green	button	under	the	All	Directories	tab	which	will	open	a	popup	window.

4.	 In	the	popup	window,	choose	Import	from	a	file	for	Choose	a	method.

5.	 Click	Choose	File	and	select	the	JSON	configuration	file	that	you	exported	earlier.	Optionally	enter	Directory
label	and	Directory	name	if	you	wish	to	change	them	from	the	ones	set	in	the	configuration	file.

6.	 Click	the	Add	Directory	button	at	the	bottom	of	the	popup	window.	A	progress	bar	will	show	up	indicating	the
status	of	the	directory	creation	process.	Make	sure	that	you	do	not	close	the	window	until	the	process	is
complete.

When	the	process	is	complete,	the	pop	window	closes	and	you	will	be	redirected	to	the	main	administration	page
of	the	directory	created.
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Updating	and	Uninstalling
In	this	section	we	will	describe	how	you	can	safely	update	Directories	Pro	to	the	latest	version	and	also	how	to
uninstall	and	completely	remove	files	and	data	of	Directories	Pro	from	your	site.
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Updating	Directories	Pro
There	are	2	ways	to	update	Directories	Pro	to	the	latest	version.	One	is	the	Automatic	Update	method	via	the
Plugins	page	of	WordPress	admin	dashboard.	Another	is	the	Manual	Update	method	using	an	FTP	software.	In
either	method,	it	is	strongly	recommended	that	you	take	a	full	backup	of	both	the	files	and	database	of	your
WordPress	website	before	updating.

Important:	You	do	NOT	need	to	deactivate	or	delete	any	of	the	Directories	Pro	plugins	from	the	Plugins	page	during
any	process.

Automatic	Update
1.	 Update	files

All	of	our	plugins	can	be	updated	from	the	Plugins	page	of	WordPress	administration	dashboard	just	like	other
plugins	distributed	from	wordpress.org.	Make	sure	that	you	have	a	valid	license	key	already	configured	to	have
the	update	now	link	appear	under	our	plugins	on	the	Plugins	page.	See	Installation	-	Register	your	License	Key
(Purchase	Code)	for	more	details	on	registering	your	license	key.

Also	when	updating,	we	recommend	updating	all	Directories	Pro	plugins	to	the	same	version	at	once.	The	best
way	to	ensure	that	is	to	use	the	bulk	update	feature	on	the	Plugins	page.

2.	 Update	components

After	updating	all	Directories	Pro	plugins,	go	to	Directories	->	System	in	the	backend.	Under	the	Tools	sub-tab,
click	the	Reload	components	button	and	follow	the	instructions	shown	on	the	popup	window	to	update	all
components.

Manual	Update
1.	 Delete	old	files

Using	your	FTP	software	of	choice,	login	to	the	FTP	server	of	your	WordPress	site	and	delete	all	folders	with
folder	names	starting	with	directories	(directories,	directories-pro,	etc.)	from	wp-content/plugins.	It	is	important
that	you	delete	these	folders	first	so	that	old	files	will	not	cause	any	issues	with	the	new	ones.

2.	 Upload	files

Download	the	latest	version	of	the	plugin	by	following	the	instructions	in	Installation	-	Download	package	and	then
unzip	all	the	zip	files	included	in	the	package	(directories.zip,	directories-pro.zip,	etc.).	With	your	FTP	software,
upload	the	unzipped	folders	(directories,	directories-pro,	etc.)	of	the	plugins	that	are	currently	activated	on	your
site	to	the	wp-content/plugins	folder	on	your	server.

3.	 Update	components

See	the	Update	components	step	for	Automatic	Update	above.
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Uninstalling	Directories	Pro
You	can	deactivate	and	delete	Directories	Pro	plugins	from	the	Plugins	page	of	WordPress	admin	dashboard	in	the
backend,	in	the	same	way	you	do	so	with	other	plugins	from	WordPress.org.

However,	if	you	simply	deactivate	and	delete	any	of	the	Directories	Pro	plugins	from	the	Plugins	page,	you	only
remove	the	plugin	and	its	files.	In	order	to	not	only	delete	plugin	files	but	also	all	the	data	associated,	follow	the	steps
below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Uninstall	sub-tab.

4.	 Select	Yes	for	the	Remove	data	option	under	the	Uninstall	Settings	section.

5.	 Click	Save	Changes	at	the	bottom.

Now,	when	you	delete	the	Directories	plugin	from	the	Plugins	page	of	WordPress	admin	dashboard,	not	only	plugins
files	but	also	all	the	data	associated	with	Directories	Pro	will	be	deleted.
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Additional	Features	and	Settings
We	will	discuss	here	about	some	of	the	additional	features	and	settings	available	with	Directories	Pro.
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Reviews
The	reviews	features	of	Directories	Pro	lets	users	submit	reviews	for	listings	in	your	directory.

Enable	reviews
Follow	these	steps	to	enable	reviews	for	your	directory:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Settings	tab,	scroll	down	the	page	and	select	Yes	for	Enable	reviews.

5.	 Scroll	further	down	and	click	Save	Changes.

Add	a	submit	review	button

Note:	If	the	reviews	feature	was	enabled	when	you	initially	created	your	directory,	then	it	is	most	likely	that	a	submit
review	button	is	already	enabled	on	the	single	listing	page.	In	that	case,	you	can	skip	this	section.

In	order	to	add	a	submit	review	button	to	the	single	listing	page	so	that	users	can	add	reviews,	you	will	need	to	edit
the	Detailed	display	of	listings:

1.	 On	your	directory	admin	main	page,	click	the	Content	Types	tab.

2.	 Click	the	dropdown	button	in	the	List	row	and	then	click	Manage	Displays.

3.	 Click	the	Detailed	sub-tab.

4.	 Locate	and	hover	over	to	the	second	Button	element	placed	under	Photos	in	the	display	and	click	the	gear	icon.

5.	 In	the	popup	window,	check	the	Add	review	button	option	under	General	Settings	->	Select	buttons.
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6.	 Click	Save	Changes.

Adding	a	review
Users	that	have	the	Create	Reviews	permission	(see	Permissions	for	details	on	permissions)	in	your	directory	can
submit	reviews	for	listings.

Follow	the	steps	below	to	submit	a	review:

1.	 Login	to	the	site	with	a	user	account	that	has	the	Create	Reviews	permission	and	visit	the	single	listing	page	of	a
listing	in	the	frontend.

2.	 A	button	labelled	Write	a	Review	should	be	visible	as	below:

Click	the	Add	Review	button.

3.	 Enter	Title,	Rating,	Review,	and	optionally	upload	Photos	and	press	Submit.

4.	 You	will	be	redirected	to	the	single	review	page	showing	the	review.

Displaying	reviews
Note:	If	the	reviews	feature	was	enabled	when	you	initially	created	your	directory,	then	it	is	most	likely	that	reviews
are	already	being	displayed	on	the	single	listing	page.	In	that	case,	you	can	skip	this	section.

Now	that	users	are	able	to	submit	reviews,	you	will	need	to	edit	the	Detailed	display	of	listings	so	that	reviews	can	be
displayed	on	the	single	listing	page.

Make	sure	first	that	you	are	on	the	Detailed	display	editor	page:	Directories	->	All	Directories	->	[Your	Directory]	->
Content	Types	->	Listing	->	Manage	Displays.

Displaying	overall	review	ratings

1.	 Click	the	Add	Element	button	at	the	bottom	of	the	page.

2.	 In	the	popup	window,	click	the	Field	tab.

3.	 Click	the	Review	Ratings	element.
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4.	 Select	Overall	Rating	for	Display	Format.

5.	 Click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

Displaying	a	list	of	reviews

1.	 Click	the	Add	Element	button	at	the	bottom	of	the	page.

2.	 In	the	popup	window,	click	the	Content	tab.

3.	 Click	the	Reviews	element.
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4.	 Select	a	view	for	Select	View.

5.	 Click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

Custom	rating	criteria
By	default,	only	a	single	rating	field	is	available	when	submitting	a	review.	If	you	wish	users	to	be	able	to	rate	listings
with	more	than	one	rating	criteria,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Review	row.

5.	 Under	the	Edit	tab,	scroll	down	to	the	Review	Settings	section	and	add	any	number	of	rating	criteria	to	Rating
criteria.	Enter	a	display	label	and	a	machine	readable	name	(slug)	for	each	option.	You	can	also	drag	the	options
up	and	down	to	change	the	display	order.

Note:	Rating	values	are	saved	using	rating	criteria	slugs	as	keys.	Therefore	changing	the	slugs	of	existing	rating
criteria	will	reset	the	values	of	those	criteria	since	old	values	can	no	longer	be	fetched	from	the	database.

6.	 Click	Save	Changes.

You	should	now	then	see	multiple	rating	fields	shown	in	the	review	submission	form	as	below:
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Claiming	Listings
When	the	claiming	feature	is	enabled,	listings	that	currently	do	not	have	any	author	assigned	can	be	claimed	by
registered	users.	If	a	claim	for	a	certain	listing	is	approved	by	the	administrator,	the	user	who	submitted	the	claim
becomes	the	author	of	the	listing.

Enable	claims
Follow	these	steps	to	enable	claims	for	your	directory:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Settings	tab,	scroll	down	the	page	and	select	Yes	for	Enable	claims.

5.	 Scroll	further	down	and	click	Save	Changes.

Claiming	a	listing
Users	with	the	Create	Claims	permission	(see	Permissions	for	details	on	permissions)	in	your	directory	can	claim
listings	from	the	single	listing	page.

Follow	the	steps	below	to	claim	a	listing:

1.	 Login	to	the	site	and	visit	the	single	listing	page	of	a	listing	to	claim.

2.	 If	the	listing	currently	has	no	author	assigned,	a	button	with	the	Claim	Listing	label	should	be	visible	similar	to
below:

Click	the	Claim	Listing	button.

3.	 Enter	the	details	for	claiming	the	listing	and	press	Submit.

If	the	submission	is	success,	a	Claim	post	with	its	claim	status	set	to	Pending	status	is	created.

Users	can	track	their	claims	either	in	the	backend	or	on	the	frontend	dashboard	page.	Claims	that	are	still	in	pending
status	can	be	edited	(requires	Edit	own	Claims	or	Edit	others	Claims	permission)	but	not	if	they	are	once	approved
or	rejected.	Claims	with	any	status	can	be	deleted	(requires	Delete	own	Claims	or	Delete	others	Claims	permission)
at	any	time.
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Managing	claims
Users	with	the	Admin	Directory	permission	can	view	all	the	claims	submitted	in	the	directory	by	visiting	the	Claims
directory	administration	page	in	the	backend.

Claims	can	be	filtered	by	date	and/or	claim	status	using	the	form	above	the	list.

In	order	to	approve/reject	a	claim,	edit	the	claim	and	select	either	Approved	or	Rejected	in	the	Claim	Status	metabox
and	then	press	Update.

When	a	claim	is	approved,	the	user	who	submitted	the	claim	immediately	becomes	the	author	of	the	listing	claimed.	In
addition,	whether	a	claim	is	approved	or	rejected,	an	e-mail	is	sent	to	the	user	who	submitted	the	claim	notifying	of	the
result	(see	Notifications	for	more	details	on	notifications).

Note:	If	your	directory	has	payments	enabled,	claims	can	be	approved/rejected	only	after	the	order	created	with	the
claim	has	been	marked	completed.

Adding	fields	to	claim	listing	form

You	can	also	add	more	fields	to	the	claim	listing	form	(see	Adding	and	Managing	Fields).	For	example,	it	may	be
useful	to	add	a	File	type	field	to	the	claim	listing	form	so	that	users	are	required	to	submit	a	certain	document	that	can
help	directory	administrators	to	determine	the	validity	of	the	claim.
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Claiming	a	multilingual	listing
If	your	directory	is	a	multilingual-enabled	directory	(see	Multilingual	Directory),	then	claiming	a	listing	is	equivalent	to
claiming	all	other	translations	(and	the	original	listing	if	the	listing	claimed	is	a	translated	listing)	of	the	listing	at	once.
Once	the	claim	is	approved,	the	user	who	submitted	the	claim	will	become	the	author	of	not	only	the	listing	claimed
but	also	its	all	translated	listings.
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Contact	Us	Form
A	contact	us	form	can	be	added	to	single	listing	pages	of	your	directory	which	lets	users	send	messages	directly	to
listing	authors.	Directories	Pro	does	not	generate	the	form	by	itself,	but	instead	provides	integration	with	a	number	of
popular	contact	form	plugins	for	WordPress.

Creating	a	contact	form
The	first	thing	you	need	to	do	is	to	create	a	contact	form	using	one	of	the	following	3rd	party	contact	form	plugins.

Contact	Form	7

The	Contact	Form	7	plugin	is	the	most	downloaded	contact	form	plugin	on	wordpress.org.

Follow	the	instructions	on	their	documentation	site	to	create	a	contact	form:	https://contactform7.com/docs/

WPForms

The	WPForms	plugin	lets	you	build	contact	forms	using	a	drag	&	drop	online	form	builder.

Follow	the	instructions	on	their	documentation	site	to	create	a	contact	form:	https://wpforms.com/docs/creating-first-
form/

Gravity	Forms

Gravity	Forms	is	a	paid	contact	form	plugin	that	has	all	the	advanced	features	one	can	ask	for.

1.	 Follow	the	instructions	on	their	documentation	site	to	create	a	contact	form:
https://www.gravityhelp.com/documentation/article/creating-a-form/

2.	 After	creating	a	form,	go	to	the	Settings	section	of	the	form.	Under	the	Notifications	tab,	create	or	edit	a
notification	with	the	Send	To	option	set	to	Enter	Email,	and	then	enter	{drts_contact_recipients}	to	the	Send	to
Email	field.

Displaying	your	contact	form
Once	you	have	created	a	contact	form,	you	can	add	the	form	to	the	single	listing	page	by	following	these	steps:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.
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2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Displays.

5.	 Click	the	Detailed	sub-tab.

Note:	The	contact	form	display	element	is	supported	by	the	Detailed	display	only.

6.	 Click	the	green	Add	Element	button	with	a	plus	sign	at	the	bottom	of	the	page.

7.	 In	the	popup	window,	click	the	Content	tab	and	then	click	the	Contact	Form	element.

8.	 Under	the	General	Settings	tab,	select	one	of	your	forms	from	the	Select	form	dropdown.

9.	 Optionally	under	the	Heading	Settings	tab,	select	Icon	+	Custom	label,	enter	Contact	Us	for	Custom	label.
Press	the	button	for	Icon,	enter	envelope	and	select	one	of	the	icons	displayed.

10.	 Click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

Visit	the	single	listing	page	of	a	listing	in	the	frontend.	Below	is	a	sample	output	of	a	contact	form	generated	by	the
Contact	Form	7	plugin.
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Contact	form	recipients
By	default,	messages	submitted	through	the	contact	form	is	sent	to	the	e-mail	address	of	the	listing	author.	However,
you	can	change	or	add	more	recipients	by	editing	the	Contact	form	recipients	setting.

As	you	can	see	above,	your	site	e-mail	address	and	the	e-mail	address	entered	for	custom	field(s)	can	also	be
selected	as	the	recipient.

If	the	payment	feature	is	enabled	in	your	directory,	the	setting	can	be	found	when	you	configure	payment	plans	or
configure	default	features.

If	the	payment	feature	is	NOT	enabled,	then	you	can	find	the	setting	under	Directories	->	Your	directory	->	Content
Types	->	Listing	->	Edit	->	General.
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Notifications
Directories	Pro	integrates	with	the	Better	Notifications	for	WordPress	(hereinafter	referred	to	as	BNFW)	plugin	to	send
various	e-mail	notifications	to	users.	Therefore	in	order	to	enable	the	notification	feature	in	your	directory,	the	BNFW
plugin	(https://wordpress.org/plugins/bnfw/)	must	first	be	installed	and	activated.

Configuring	notifications
Directories	Pro	creates	the	following	notifications	in	BNFW:

Directory	–	Listing	–	Pending	Review	-	Sent	to	administrators	when	a	new	listing	that	requires	manual	approval
has	been	submitted.

If	reviews	are	enabled	in	your	directory:

Directory	–	Review	–	Pending	Review	-	Sent	to	administrators	when	a	new	review	that	requires	manual
approval	has	been	submitted.

If	payments	are	enabled	in	your	directory:

Directory	–	Listing	–	Expiring	-	Sent	to	the	author	of	a	listing	when	the	payment	plan	associated	with	the	listing
is	about	to	expire	(defaults	to	7	days	before	expiration).

Directory	–	Listing	–	Expired	-	Sent	to	the	author	of	a	listing	when	the	payment	plan	associated	with	the	listing
has	expired.

Directory	–	Listing	–	Deactivated	-	Sent	to	the	author	of	a	listing	when	the	listing	has	been	deactivated	(defaults
to	30	days	after	expiration).

If	claims	are	enabled	in	your	directory:

Directory	–	Listing	–	Claim	Pending	Review	-	Sent	to	administrators	when	a	new	claim	for	a	listing	has	been
submitted.

Directory	–	Listing	–	Claim	Approved	-	Sent	to	the	user	submitted	a	claim	for	a	listing	when	the	claim	has	been
approved.

Directory	–	Listing	–	Claim	Rejected	-	Sent	to	the	user	submitted	a	claim	for	a	listing	when	the	claim	has	been
rejected.

Note:	If	for	some	reason	you	do	not	see	the	above	notifications	created,	try	reloading	all	components	from
Directories	->	System	->	Tools.

To	configure	these	notifications,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Notifications	->	All	Notifications	from	the	side	menu.	The	page	should	look	like	below:
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3.	 Hover	over	to	the	one	of	the	notifications	above	and	click	the	Edit	link	shown	in	the	Title	column	of	the
notification.	Edit	notification	page	is	displayed	with	the	following	notification	settings:
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Notification	for	-	Select	the	type	of	notification.	You	do	not	need	to	change	this	option	unless	you	know	what
you	are	trying	to	do.

Email	Formatting	-	Whether	or	not	to	send	the	notification	e-mail	in	HTML	(recommended)	or	plain	text.

Additional	Email	Fields

Set	"From"	Name	&	Email,	Reply	To,	CC,	BCC	-	Lets	you	configure	additional	e-mail	headers.

Send	this	notification	to	the	Author	only	-	Check	this	option	to	send	the	notification	only	to	the	author
of	the	content	item.	If	this	was	already	checked,	we	recommend	leaving	it	as-is.

Do	not	send	this	Notification	to	the	User	that	triggered	it	-	Check	this	option	if	you	do	not	want	the
notification	e-mail	to	be	sent	for	the	actions	that	users	performed	for	their	own	posts.

Send	To	-	Select	user	roles	or	individual	users	as	recipients	of	the	notification	e-mail.

Subject	-	Enter	the	subject	of	the	notification	e-mail.	Notification	shortcodes	may	be	used	in	this	field.

Message	Body	-	Enter	the	body	part	of	the	notification	e-mail.	Notification	shortcodes	may	be	used	in	this
field.

4.	 Click	the	Save	button	in	the	Save	Notification	metabox	shown	on	the	side.

Notification	shortcodes
You	can	use	shortcodes	for	the	Subject	and	Message	Body	fields	when	configuration	a	notification.	Visit	the
following	shortcode	documentation	page	of	the	BNFW	plugin	website	for	the	list	of	shortcodes	that	you	can	use	for
each	notification	type:	https://betternotificationsforwp.com/documentation/notifications/shortcodes/

In	addition	to	default	shortcodes	provided	by	the	BNFW	plugin,	below	are	the	list	of	shortcodes	enabled	by	Directories
Pro	which	you	can	use	for	directory	listing	and	claim	notifications.
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	[drts_entity]	

Displays	a	single	field	or	all	fields	of	the	listing.

Parameters:

	field		-	Specify	the	machine	readable	name	of	a	field	defined	for	listings	(e.g.		post_title	,
	field_email	,		business_photos	),	defaults	to	none.	If	none	specified,	then	all	fields	that	can	be	rendered
in	human	readable	format	will	be	displayed.

	format		-	Specify	the	render	format	of	the	field(s)	displayed.	Use		%label%		and		%value%		placeholders
which	are	replaced	with	actual	field	labels	and	human	readable	values	(e.g.		%label%:	%value%	).	If	none
specified,	field	label	and	value	pair	will	be	displayed	in	the	following	format:

--	%label%	--

%value%

	separator		-	Specify	a	string	that	will	be	used	to	separate	values	if	the	field	has	multiple	values,	defaults
to	a	string	specific	to	each	field.

	[drts_entity_admin_url]	

Displays	the	URL	of	the	listing	index	page	in	the	backend.

	[drts_payment_expire_days]	

Displays	the	number	of	days	remaining	until	the	expiration	date	of	the	listing.

	[drts_payment_expire_on]	

Displays	the	expiration	date	of	the	listing.

	[drts_payment_renew_grace_period]	

Displays	the	number	of	days	listings	are	kept	published	after	expiration	until	they	are	deactivated.

	[drts_dashboard_url]	

Displays	the	URL	of	the	dashboard	page	in	the	frontend.

Parameters:

	post_status		-	Specify	the	post	status	of	listings	to	display	on	the	dashboard	page,	can	be	either	one	of
	publish	/	pending	/	draft	/	expired	/	deactivated	/	expiring	,	defaults	to	none.

The	following	shortcodes	are	available	for	claim/review	notifications.

	[drts_child_entity]	

Works	exactly	the	same	as		[drts_entity]		but	displays	content	of	a	claim/review.

	[drts_child_entity_admin_url]	

Displays	the	URL	of	the	claim	index	page	in	the	backend.
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Map	Display	Settings
Follow	the	steps	below	to	configure	common	settings	applied	by	default	to	all	maps	displayed	in	Directories	Pro:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab.

4.	 Click	the	Map	sub-tab	and	configure	the	following	settings	available	under	the	Display	Settings	section:

Default	map	type	-	Select	the	default	map	type	to	use	to	display	maps,	from	Google	(roadmap),	Google
(satellite),	Google	(hybrid),	or	OpenStreetMap.

This	setting	is	available	only	when	Google	Maps	is	selected	as	the	map	provider.

Default	map	style	-	Select	a	custom	Google	Maps	style	to	be	applied	by	default.

This	setting	is	available	only	when	Google	Maps	is	selected	as	the	map	provider.

Distance	unit	-	Select	Kilometers	or	Miles.

Default	zoom	level	-	Specify	the	default	zoom	level	of	the	map.
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Default	location	-	Specify	the	default	location	displayed	on	the	map.	Click	Enter	coordinates	manually	to
manually	enter	latitude	and	longitude	coordinates.

Enable	scrollwheel	zooming	on	map	-	Whether	or	not	to	enable	zooming	in/out	on	the	map	using	the
scrollwheel	of	the	mouse.

Enable	custom	markers	-	Whether	or	not	to	show	custom	styled	map	markers.

Custom	marker	color	-	Select	the	color	of	custom	map	markers.

Custom	marker	icon	-	Select	the	icon	shown	on	custom	map	markers.

Custom	marker	icon	color	-	Select	the	color	of	icon	shown	on	custom	map	markers.

Enable	marker	clusters	-	Whether	or	not	to	cluster	map	markers	and	show	the	number	of	items	in	each
cluster.

Marker	cluster	color	-	Select	the	color	of	marker	clusters.

Fit	all	markers	inside	map	-	Whether	or	not	to	automatically	zoom	in/out	the	map	so	that	all	map	markers	fit
inside	the	current	viewport	of	the	map.

5.	 Scroll	down	the	page	and	click	Save	Changes.
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Permissions
Permissions	in	Directories	Pro	define	what	a	specific	user	can	and	cannot	do	in	your	directory	and	can	be	granted	or
revoked	on	per	user	role	basis.	In	addition	to	regular	user	roles	in	WordPress,	a	virtual	Guest	user	role	is	available
which	can	be	used	to	assign	permissions	to	non-logged	in	users.

Note:	If	you	are	familiar	with	the	WordPress	capability	system,	permissions	in	Directories	Pro	are	WordPress
capabilities.

Configuring	permissions
To	configure	permissions,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Click	the	Permissions	tab.

Grant	or	revoke	permissions	by	checking/unchecking	the	checkboxes	under	each	user	role.	Here	are	the
permissions	that	are	configurable	by	default:

Listing:

Read	Listings	-	Allows	access	to	single	listing	pages	in	the	frontend.

Create	Listings	-	Allows	submitting	new	listings.

Publish	Listings	-	Allows	new	listings	submitted	to	become	published	without	moderation.

Edit	own	Listings	-	Allows	editing	own	(authored)	listings.

Edit	others	Listings	-	Allows	editing	listings	authored	by	other	users.

Edit	published	Listings	-	Allows	editing	listings	that	have	already	been	published.	Even	listing	authors
may	not	edit	their	published	listings	without	this	permission.

Delete	own	Listings	-	Allows	deleting	own	(authored)	listings.

Delete	others	Listings	-	Allows	deleting	listings	authored	by	other	users.
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Delete	published	Listings	-	Allows	deleting	listings	that	have	already	been	published.	Even	listing
authors	may	not	delete	their	published	listings	without	this	permission.

Rate	Listings	-	Allows	rating	listings	with	stars.

Rate	own	Listings	-	Allows	rating	own	(authored)	listings	with	stars.	Requires	Rate	Listings
permission.

Claim:

Create	Claims	-	Allows	claiming	listings	from	the	frontend.

Edit	own	Claims	-	Allows	editing	own	(authored)	claims.

Edit	others	Claims	-	Allows	editing	claims	submitted	by	other	users.

Delete	own	Claims	-	Allows	deleting	own	(authored)	claims.

Delete	others	Claims	-	Allows	deleting	claims	submitted	by	other	users.

Review:

Read	Reviews	-	Allows	access	to	single	review	pages	in	the	frontend.

Create	Reviews	-	Allows	submitting	new	reviews	from	the	frontend.

Publish	Reviews	-	Allows	new	reviews	submitted	to	become	published	without	moderation.

Edit	own	Reviews	-	Allows	editing	own	(authored)	reviews.

Edit	others	Reviews	-	Allows	editing	reviews	authored	by	other	users.

Edit	published	Reviews	-	Allows	editing	reviews	that	have	already	been	published.	Even	review
authors	may	not	edit	their	published	reviews	without	this	permission.

Delete	own	Reviews	-	Allows	deleting	own	(authored)	reviews.

Delete	others	Reviews	-	Allows	deleting	reviews	authored	by	other	users.

Delete	published	Reviews	-	Allows	deleting	reviews	that	have	already	been	published.	Even	review
authors	may	not	delete	their	published	reviews	without	this	permission.

Moderate	comments	-	Allows	moderating	comments	posted	for	reviews.

Vote	up	Reviews	-	Allows	voting	reviews	up.

Vote	up	own	Reviews	-	Allows	voting	own	(authored)	reviews	up.	Requires	Vote	up	Reviews
permission.

Vote	down	Reviews	-	Allows	voting	reviews	down.	Requires	Vote	up	Reviews	permission.

Category/Tag/Location:

Manage	Categories/Tags/Locations	-	Allows	viewing	the	list	of	categories/tags/locations	in	the
backend.

Edit	Categories/Tags/Locations	-	Allows	adding	or	editing	categories/tags/locations	in	the	backend.

Delete	Categories/Tags/Locations	-	Allows	deleting	categories/tags/locations	in	the	backend.

Assign	Categories/Tags/Locations	-	Allows	assigning	categories/tags/locations	(including	creating
new	tags)	to	listings.

Admin:
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Admin	Directory	-	Allows	access	to	the	Settings,	Content	Types,	Permissions	configuration	pages	of
the	directory.

5.	 Scroll	down	the	page	and	press	Save	Changes.

Administrators

A	user	is	considered	an	administrator	of	Directories Pro	if	the	user	meets	one	of	the	following	requirements:

Has	the	manage_directories	WordPress	capability
Has	the	delete_users	WordPress	capability
Is	a	network	administrator	(if	multisite	enabled)

Administrators	are	allowed	access	to	all	pages	of	Directories	Pro	in	the	backend	as	well	as	are	granted	all
permissions	of	all	the	directories	created.	If	you	wish	to	let	other	user	roles	to	become	administrators	of	Directories
Pro,	you	can	grant	the	manage_directories	or	delete_users	WordPress	capability	to	those	user	roles.	Since
WordPress	itself	does	not	have	an	interface	for	managing	capabilities,	we	recommend	using	the	Capability	Manager
Enhanced	plugin	to	do	so.

Limiting	Backend	Dashboard	Access
By	default,	WordPress	allows	registered	users	to	access	the	backend	dashboard	to	manage	their	user	profiles	and
content.	If	you	prefer	users	without	administrative	privileges	kept	outside	the	backend	dashboard,	we	recommend
installing	and	activating	the	Remove	Dashboard	Access	plugin.	By	using	the	plugin,	you	can	limit	backend	dashboard
access	by	user	roles	or	by	a	capability.

Note	that	users	that	belong	to	user	roles	that	have	the	permission(s)	to	add/edit/delete	posts	(listings,	claims,	and
reviews)	will	no	longer	be	able	to	do	so	if	they	are	not	able	to	access	the	backend	dashboard.	If	you	wish	those	users
to	still	be	able	to	submit	and	manage	their	posts,	make	sure	to	install	the	Directories	-	Frontend	plugin	which	lets	you
create	a	frontend	dashboard	for	users	to	manage	their	content	in	the	frontend.	See	Frontend	Submit	and	Dashboard
for	more	details.
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SEO	Features

Custom	permalink	URLs
Custom	permalink	URLs	can	be	setup	for	listings,	categories,	tags,	and	locations.	Here	is	how	you	can	do	so	for
listings:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.

5.	 Scroll	down	to	the	Single	Item	Page	Settings	section	and	switch	on	the	Enable	custom	permalink.

Enter	the	base	part	of	the	custom	permalink	URL	into	the	text	field	(default:	directory-listing).	Then,	select	one
of	the	formats	used	for	the	rest	of	the	URL	from	below:

%id%	-	Displays	the	ID	of	the	current	listing.	Example:		http://example.com/directory-listing/12	

%slug%	-	Displays	the	slug	of	the	current	listing.	Example:		http://example.com/directory-listing/company-
name	

%directory_category%	/	%id%	-	Displays	slugs	of	categories	associated	with	the	current	listing	in
hierarchical	order	followed	by	the	ID	of	the	current	listing.	Example:		http://example.com/directory-
listing/arts/performing/12	

%directory_category%	/	%slug%	-	Displays	slugs	of	categories	associated	with	the	current	listing	in
hierarchical	order	followed	by	the	slug	of	the	current	listing.	Example:		http://example.com/directory-
listing/arts/performing/company-name	

%directory_tag%	/	%id%	-	Displays	the	slug	of	the	primary	tag	associated	with	the	current	listing	followed
by	the	ID	of	the	current	listing.	Example:		http://example.com/directory-listing/tag1/12	

%directory_tag%	/	%slug%	-	Displays	the	slug	of	the	primary	tag	associated	with	the	current	listing	followed
by	the	slug	of	the	current	listing.	Example:		http://example.com/directory-listing/tag1/company-name	

%location_location%	/	%id%	-	Displays	slugs	of	locations	associated	with	the	current	listing	in	hierarchical
order	followed	by	the	ID	of	the	current	listing.	Example:		http://example.com/directory-listing/united-
states/new-york/ardsley/12	

%location_location%	/	%slug%	Displays	slugs	of	locations	associated	with	the	current	listing	in	hierarchical
order	followed	by	the	ID	of	the	current	listing.	Example:		http://example.com/directory-listing/united-
states/new-york/ardsley/company-name	

6.	 Scroll	further	down	the	page	and	click	Save	Changes.

Configuring	schema.org	structured	data
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Structured	data	using	the	schema.org	vocabulary	is	enabled	by	default	for	listings	(LocalBusiness).	When	you	visit	a
single	listing	page,	an	HTML	fragment	containing	JSON-formatted	structured	data	(JSON-LD)	similar	to	the	one	below
can	be	seen	embedded	in	the	HTML	source	of	the	page.

<script	type="application/ld+json">

{

		"@context":"http:\/\/schema.org",

		"@type":"LocalBusiness",

		"description":"Saepe	repellat	praesentium	vel	tempora	nesciunt	ut	expedita.	Cum	odit	aut	saepe	provident.	Com

modi	velit	aspernatur	tempora.	Dicta	veniam	impedit	dolor	fugit.	Aut	repudiandae	minus	molestiae	laboriosam	aut

.	Incidunt	et	vel	eius	nulla.",

		"name":"PinotDevice",

		"telephone":"(474)715-7009",

		"faxNumber":"245.718.8680",

		"email":"yshields@gmail.com",

		"url":"http:\/\/www.deckow.com\/minus-sapiente-sed-hic-ut-ipsam",

		"sameAs":[

				"http:\/\/staff.tumblr.com\/",

				"https:\/\/www.flickr.com\/people\/flickr"

		],

		"openingHoursSpecification":[

				{

						"@type":"OpeningHoursSpecification",

						"dayOfWeek":["Wednesday"],

						"opens":"12:58",

						"closes":"02:08"

				},

				{

						"@type":"OpeningHoursSpecification",

						"dayOfWeek":["Wednesday"],

						"opens":"15:40",

						"closes":"23:39"

				},

				{

						"@type":"OpeningHoursSpecification",

						"dayOfWeek":["Sunday"],

						"opens":"08:47",

						"closes":"01:43"

				},

				{

						"@type":"OpeningHoursSpecification",

						"dayOfWeek":["Friday"],

						"opens":"03:00",

						"closes":"10:00"

				}

		],

		"priceRange":"$69	-	$87",

		"image":"https:\/\/demo.directoriespro.com\/wp-content\/uploads\/2018\/03\/file000626266718.jpg",

		"address":{

				"@type":"PostalAddress",

				"addressCountry":"US",

				"addressLocality":"Elmhurst",

				"addressRegion":"Illinois",

				"postalCode":"60126",

				"streetAddress":"Dwight	D.	Eisenhower	Expressway"

		},

		"geo":{

				"@type":"GeoCoordinates",

				"latitude":41.917085,

				"longitude":-87.944521

		}

}

</script>

You	can	configure	what	data	should	be	included	in	JSON-LD	by	following	the	steps	below:
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1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.

5.	 Scroll	down	to	the	SEO	Settings	section.	For	the	Schema.org	JSON-LD	setting,	select	a	schema	type	that	best
describes	your	listings	and	map	the	properties	of	the	schema	type	with	listing	fields.

6.	 After	making	changes,	scroll	further	down	the	page	and	click	Save	Changes.

Adding	Open	Graph	meta	tags
The	Open	Graph	protocol	enables	any	web	page	to	become	a	rich	object	in	a	social	graph.	For	example,	listings	can
have	their	meta	data	embedded	in	the	HTML	source	of	the	single	listing	page	using	the	Open	Graph	protocol	markup
as	below:

<meta	property="og:site_name"	content="Directories	Pro	Demo"	/>

<meta	property="og:type"	content="business.business"	/>

<meta	property="og:url"	content="https://demo.directoriespro.com/directory/listing/legumesqueue/"	/>

<meta	property="og:title"	content="LegumesQueue"	/>

<meta	property="og:description"	content="Fugiat	maxime	laborum	aut	vel	unde.	Omnis	voluptas	minus	aut.	Corrupti

	qui	sint	ipsum	voluptas	et	sed	aspernatur	consectetur.	Maxime	adipisci	et	repellat	quia	accusantium	aut.		Veri

tatis	nisi	sunt	alias	consequuntur	voluptates	eos	magnam.	Accusamus	distinctio	distinctio	sunt	facere	tempore.	

Quia	..."	/>

<meta	property="business:hours:day"	content="sunday"	/>

<meta	property="business:hours:start"	content="22:02"	/>

<meta	property="business:hours:end"	content="21:28"	/>

<meta	property="business:hours:day"	content="thursday"	/>

<meta	property="business:hours:start"	content="01:22"	/>

<meta	property="business:hours:end"	content="07:30"	/>

<meta	property="business:hours:day"	content="friday"	/>

<meta	property="business:hours:start"	content="16:10"	/>

<meta	property="business:hours:end"	content="19:08"	/>

<meta	property="business:hours:day"	content="sunday"	/>

<meta	property="business:hours:start"	content="12:26"	/>
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<meta	property="business:hours:end"	content="23:01"	/>

<meta	property="business:hours:day"	content="saturday"	/>

<meta	property="business:hours:start"	content="09:19"	/>

<meta	property="business:hours:end"	content="18:46"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/DSC_6137-300x199.

jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file7561294493011

-300x200.jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file0001706961259

-300x225.jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file0001565782100

-300x200.jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file0001735386118

-300x225.jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file761244456443-

300x199.jpg"	/>

<meta	property="og:image"	content="https://demo.directoriespro.com/wp-content/uploads/2017/03/file4741298583098

-1-300x191.jpg"	/>

<meta	property="business:contact_data:street_address"	content="6605	North	93RD	Avenue"	/>

<meta	property="business:contact_data:locality"	content="Glendale"	/>

<meta	property="business:contact_data:region"	content="AZ"	/>

<meta	property="business:contact_data:postal_code"	content="85305"	/>

<meta	property="business:contact_data:country_name"	content="US"	/>

In	order	to	add	Open	Graph	meta	tags	to	single	listing	pages,	follow	these	steps:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.

5.	 Scroll	down	to	the	Open	Graph	meta	tags	setting	under	the	SEO	Settings	section.

Select	the	type	of	Open	Graph	object	that	best	represents	your	listings	from	the	dropdown	and	then	select	a	best
matching	listing	field	for	each	property	shown	below.
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Properties	that	you	can	configure	change	depending	on	the	object	type	selected.	See	Open	Graph	Reference
Documentation	for	the	detailed	information	of	each	object	type	and	its	associated	properties.

6.	 Scroll	further	down	the	page	and	click	Save	Changes.

Displaying	breadcrumbs
Directories	Pro	is	compatible	with	the	breadcrumbs	feature	of	Yoast	SEO	(https://wordpress.org/plugins/wordpress-
seo/)	and	Breadcrumb	NavXT	(https://wordpress.org/plugins/breadcrumb-navxt/)	plugins.	If	you	currently	have	one	of
these	plugins	activated	and	its	breadcrumbs	feature	enabled,	then	breadcrumbs	should	already	display	properly	on
directory	pages.

See	pages	below	for	more	details	on	the	breadcrumbs	feature	of	the	plugins:

Yoast	SEO	-	https://kb.yoast.com/kb/implement-wordpress-seo-breadcrumbs/

Breadcrumb	NavXT	-	https://mtekk.us/code/breadcrumb-navxt/
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Customizing	Pages
Directory	pages	and	single	post/term	pages	can	be	customized	using	shortcodes.

Customizing	directory	pages
Directory	pages	can	be	customized	by	editing	the	page	assigned	to	each	directory	page	in	Directories	->	Settings	->
Pages.

For	example,	here	is	how	you	can	add	a	notice	above	the	directory	index	page	of	your	directory.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Pages	sub-tab.

4.	 Scroll	down	to	Page	Settings	and	copy	the	shortcode	shown	under	the	dropdown	field	for	your	directory.

5.	 Click	the	Edit	link	next	to	the	dropdown	field	to	edit	the	page.	Paste	the	shortcode	copied	in	step	4	to	the	content
section	of	the	page	and	add	a	custom	notice	message	above	the	shortcode.

6.	 Update	the	page,	and	the	page	will	now	look	like	below	in	the	frontend.
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Customizing	single	post/term	pages
In	order	to	customize	single	post	and	term	pages,	a	separate	page	needs	to	be	assigned	first	to	each	post	type	or
taxonomy.

Here	is	how	you	can	assign	a	page	for	listings:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	that	you	wish	to	configure.

4.	 Under	the	Content	Types	tab,	click	the	Edit	button	in	the	Listing	row.

5.	 Scroll	down	to	Single	Item	Page	Settings	and	select	a	page	from	the	Assign	page	dropdown	field.

6.	 Scroll	further	down	and	click	Save	Changes.

You	can	now	edit	the	page	to	customize	how	a	listing	is	rendered	on	the	single	listing	page.

You	can	add	custom	content	to	the	content	section	of	the	page,	however	when	you	do	so	make	sure	to	insert	the
	[drts-entity]		shortcode	where	the	listing	content	should	be	displayed.

[drts-entity]	shortcode

This	shortcode	will	display	the	full	content	of	the	post/term	currently	viewed	when	used	without	any	parameter.

[drts-entity]

If	you	are	editing	the	content	section	of	the	page,	make	sure	to	insert	the	shortcode	to	where	the	full	content	of	the
post/term	currently	viewed	should	be	displayed.
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You	can	also	use	the	shortcode	to	output	a	single	field	value	or	a	partial	content	rendered	by	a	display	element	for	the
currently	viewed	post/term.	This	is	useful	for	example	when	you	want	to	use	a	page	builder	plugin	to	fully	design	how
the	field	values	and	content	of	a	post/term	is	displayed	on	the	single	item	page.

Displaying	a	field	value

Use	the	field	parameter	to	display	a	value	of	a	specific	field	of	the	currently	viewed	post/term.

[drts-entity	field="xxx"]

where		xxx		represents	the	name	of	field	to	display.	This	will	output	a	human	readable	text	value	of	the	specified	field
for	the	currently	viewed	post/term.

Note	that	not	all	field	types	are	supported	by	this	method.

Displaying	a	display	element

Use	the	display_element	parameter	to	show	a	display	element	of	the	Detailed	display.

[drts-entity	display_element="xxx"]

where		xxx		represents	the	ID	of	a	display	element.

For	example,	follow	the	steps	below	to	get	the	shortcode	for	a	display	element	of	the	Detailed	display	of	listings.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Under	the	All	Directories	tab,	click	the	gear	icon	in	the	row	of	the	directory	to	edit.

4.	 Under	the	Content	Types	tab,	click	the	dropdown	button	in	the	Listing	row	and	then	click	Manage	Displays.
Make	sure	the	Detailed	display	is	selected.

5.	 Hover	over	to	the	display	element	that	you	wish	to	get	a	shortcode	for	and	click	the	information	button	(turquoise
colored	button	with	"i").
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6.	 Copy	the	shortcode	displayed	in	the	popup	box.
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Template	Files
Customizing	displays	using	the	built-in	display	editor	can	sometimes	be	a	tedious	task	for	developers	or	designers.
You	may	prefer	writing	code	and	have	full	control	over	how	content	items	are	rendered	and	styled	in	the	frontend.	This
is	where	template	files	for	displays	come	into	play.

Template	file	types
There	are	2	types	of	template	files	for	customizing	displays	in	Directories	Pro:

Display	template	files
Element	template	files

Display	template	files

Display	template	files	let	you	have	full	control	over	how	displays	are	rendered.	When	you	create	a	display	template	file
for	a	given	display	(Detailed,	Summary,	etc.)	of	a	certain	content	type,	the	output	of	each	content	item	for	the	display
will	be	generated	solely	from	the	template	file.	Any	configurations	or	modifications	added	through	the	display	editor
are	ignored.	Therefore	display	template	files	are	for	advanced	developers	and	not	recommended	unless	you	know
what	you	are	trying	to	do.	If	you	are	simply	trying	to	customize	certain	parts	of	a	display,	consider	using	element
template	files	instead.

Display	template	files	must	be	saved	with	its	file	name	formatted	as:

xxxx-display_yyyy.html.php

where	xxxx	is	the	machine	readable	name	of	a	content	type	(e.g.	directory__listing)	and	yyyy	is	that	of	a	display	(e.g.
detailed).

To	check	the	machine	readable	name	of	a	content	type,	go	to	Directories	->	All	Directories,	and	then	to	the	Content
Types	page	(or	tab)	of	your	directory.	The	text	strings	shown	in	parentheses	under	the	Content	Type	column	in	the
table	are	the	machine	readable	name	of	each	content	type.	As	for	the	machine	readable	name	of	a	display,	simply
convert	the	name	of	the	display	to	lower	case	and	then	change	spaces	to	underscores.

For	example,	below	are	the	names	of	display	template	files	for	listings:

Detailed	-		directory__listing-display_detailed.html.php	
Summary	-		directory__listing-display_summary.html.php	
Dashboard	Row	-		directory__listing-display_dashboard_row.html.php	

Once	you	create	a	display	template	file	for	a	display	and	place	it	under	a	valid	file	location,	you	will	see	a	warning
message	similar	to	below	appear	at	the	top	of	the	display	editor:

This	confirms	that	your	display	template	file	is	enabled	and	used	to	render	the	display,	and	whatever	you	configure	on
the	display	editor	is	ignored	as	long	as	the	template	file	exists.

Element	template	files
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Element	template	files	are	useful	when	you	need	to	customize	only	a	certain	part	of	a	display.	Element	template	files
are	rendered	by	the	Template	element	or	the	Field	Template	element	within	a	display.	Simply	add	these	elements
through	the	display	editor	and	place	them	anywhere	within	the	display	just	like	you	do	with	other	elements.

The	Template	and	Field	Template	elements	both	have	a	setting	labeled	Template	file	which	lets	you	select	a
template	file	to	be	loaded	and	rendered	by	the	element:

There	is	no	template	file	selectable	by	default	so	you	will	need	to	create	one	in	order	to	use	the	element.

Element	template	files	must	be	saved	with	its	file	name	formatted	as:

xxxx-element_yyyy.html.php

where		xxxx		is	the	machine	readable	name	of	a	content	type	(e.g.	directory__listing)	and		yyyy		can	be	any	number
of	alphanumeric	lowercase	characters	(a-z,0-9)	or	underscores.

For	example,	if	there	is	a	template	file	named		directory__listing-element_test_template.html.php	,	then	you	will	see
an	option	added	to	the	Template	file	setting	as	below:

As	you	can	see,	the		yyyy		part	of	the	template	file	name,		test_template		in	this	case,	is	used	as	the	label	of	the
template	file	in	the	setting	(shown	as	Test	Template).

Template	vs	Field	Template	elements

The	difference	between	the	Template	and	the	Field	Template	elements	is	that	the	Field	Template	element	is
handled	as	a	Field	type	element.	This	lets	you	add	Field	Template	elements	to	a	Field	List	element,	which	allows
only	Field	type	elements	to	be	contained,	so	that	you	can	display	your	template	content	along	with	other	Field	type
elements.

Another	difference	is	that	Template	elements	are	handled	as	block-level	HTML	elements	whereas	Field	Template
elements	as	inline	HTML	elements.

Template	file	location
Template	files	can	be	placed	under	the	following	directory:

wp-content/themes/[Your_Current_Theme]/drts

where		[Your_Current_Theme]		is	the	name	of	the	theme	that	is	currently	active	on	your	site.	You	will	need	to	manually
create	the		drts		folder	if	it	does	not	exist	under	your	theme	directory.	Make	sure	to	clear	the	cache	from	Directories	-
>	Settings	->	Tools	once	you	create	the	folder.
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Note:	If	you	are	currently	not	using	a	child	theme,	it	is	strongly	recommended	that	you	create	a	child	theme	of	the
current	theme	first	and	then	create	the		drts		folder	under	that	child	theme.	Otherwise,	the		drts		folder	and	your
template	files	in	the	folder	will	be	removed	when	you	update	the	current	theme.	For	more	details	on	child	themes,	see
the	following	page:	https://codex.wordpress.org/Child_Themes

Alternatively,	you	can	place	your	template	files	under	the	following	directory:

wp-content/drts/assets

You	will	need	to	manually	create	the	directory	if	it	does	not	exist	and	then	clear	the	cache	from	Directories	->
Settings	->	Tools.	You	can	place	your	template	files	under	this	directory	if	you	wish	them	to	be	used	not	only	by	the
current	theme	but	by	other	themes	as	well.

Template	files	are	searched	in	the	following	order:

If	the	current	theme	is	a	child	theme:

1.	 	drts		folder	of	the	current	theme

2.	 	wp-content/drts/assets	

3.	 	drts		folder	of	the	parent	theme

If	your	theme	is	not	a	child	theme:

1.	 	wp-content/drts/assets	

2.	 	drts		folder	of	the	current	theme

Note:	Make	sure	to	always	clear	the	cache	from	Directories	->	Settings	->	Tools	when	you	create	or	remove	any	of
the	directories	above.

Creating	a	template	file
Now	let's	create	a	template	file	and	try	adding	some	code	to	it.	We	will	create	an	element	template	file	for	listings
which	generates	a	list	of	RSS	feed	items	of	the	currently	viewed	listing	if	the	listing	has	an	RSS	feed	URL	entered	for
the	Social	Accounts	field.	We	will	then	display	the	template	using	the	Template	element.

1.	 Create	an	empty	file	named		directory__listing-element_rss_feed.html.php		and	place	it	under		wp-
content/drts/assets	.

2.	 Copy	and	paste	the	following	code	to	the	file	created	in	step	1:

<?php

$social_accounts	=	get_post_meta($entity->post()->ID,	'_drts_field_social_accounts',	true);

if	(!$social_accounts	||	!isset($social_accounts['rss']))	return;

$rss	=	fetch_feed($social_accounts['rss']);

if	(is_wp_error($rss))	{

				$this->LogError($rss);

				return;

}

$items	=	$rss->get_items(0,	5);

if	(empty($items))	return;

?>

<ul>

<?php	foreach	($items	as	$item):?>

				<li><a	href="<?php	echo	esc_url($item->get_permalink());?>"	title="<?php	echo	esc_attr(sprintf('Posted	

%s',	$item->get_date('j	F	Y	|	g:i	a')));?>"><?php	echo	esc_html($item->get_title());?></a></li>
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<?php	endforeach;?>

</ul>

If	you	know	PHP	then	you	may	have	noticed	in	the	code	above	that	there	is	an		$entity		PHP	variable	that	is
coming	from	nowhere.	It	is	a	PHP	object	(instance	of	\SabaiApps\Directories\Component\Entity\Type\IEntity)
representing	the	currently	viewed	content	item	(listing,	category,	tag,	etc.),	which	is	passed	to	the	template	by	the
system	when	the	template	is	loaded.

If	the	current	content	item	is	a	post,	then	you	can	get	a	WordPress	post	object	using	the		post()		method	of	the
	$entity		object:

$post	=	$entity->post();

Similarly,	if	the	current	content	item	is	a	taxonomy	term,	you	can	get	a	WordPress	taxonomy	term	object	using
the		term()		method	of	the		$entity		object:

$term	=	$entity->term();

Both	methods	will	return		NULL		if	a	post	or	term	was	not	found	or	in	case	of	an	error.

In	case	you	need	to	check	if	the	current	content	item	is	a	post	or	a	term	object,	you	can	use	the
	isTaxonomyTerm()		method:

if	($entity->isTaxonomyTerm())	{

				$term	=	$entity->term();

}	else	{

				$post	=	$entity->post();

}

Now,	let's	get	back	to	the	code	and	take	a	look	at	the	following	part:

$social_accounts	=	get_post_meta($entity->post()->ID,	'_drts_field_social_accounts',	true);

Since	we're	creating	a	template	file	for	listings,	the		post()		method	is	used	to	fetch	a	WordPress	post	object.
Then	the	WordPress		get_post_meta		function	is	used	to	get	a	value	of	the	Social	Accounts	field	entered	for	the
listing.	The	meta	key	for	fields	in	Directories	Pro	plugins	takes	the	following	format:

_drts_xxxx

where		xxxx		is	the	machine	readable	name	of	a	field.

Note:	To	check	the	machine	readable	name	of	a	field,	go	to	the	Content	Types	page	(or	tab)	of	your	directory,
click	the	dropdown	button	in	the	row	of	the	content	type	to	check	and	click	Manage	Fields.	On	the	form	editor
page,	hover	over	to	the	field	element	you	are	looking	for	and	then	to	the	bluish-green	info	button.	A	popup	will	be
displayed	showing	all	the	meta	information	of	the	element	as	below:

Template	Files

166

https://developer.wordpress.org/reference/classes/wp_post/
https://developer.wordpress.org/reference/classes/wp_term/


The	value	of	the	field	name	column	in	the	popup	is	the	machine	readable	name	of	the	field.

Getting	back	to	the	code,	the	following	line	makes	sure	that	a	value	for	the	Social	Accounts	field	exists	and	that
an	RSS	feed	URL	has	been	entered:

if	(!$social_accounts	||	!isset($social_accounts['rss']))	return;

As	you	can	see	above,	you	can	use		return		to	abort	the	rendering	of	the	template	file	and	return	an	empty
content	to	the	current	display.

The	remaining	part	of	the	code	simply	uses	the		fetch_feed()		function	available	in	WordPress	to	fetch	an	RSS
feed	from	a	URL	and	then	renders	it	as	an	unordered	list.	For	more	details	on	the		fetch_feed()		function,	see	the
WordPress	Codex

3.	 Save	the	template	file.

Now	the	template	file	has	been	created,	let's	add	a	template	element	to	the	Detailed	display	of	listings.

1.	 Go	to	the	Manage	Displays	page	for	listings	and	on	the	Detailed	display	editor,	click	the	green	Add	Element
with	a	plus	sign	at	the	bottom	of	the	page.

2.	 In	the	popup	window,	select	the	Content	tab	and	click	Template.

3.	 Under	the	General	Settings	tab,	select	Rss	Feed	for	the	Template	file	setting.

4.	 Under	the	Heading	Settings	tab,	configure	as	follows:
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Label	-	Custom	label

Custom	label	-	RSS	Feed

5.	 Leave	other	settings	as-is	and	click	the	Add	Element	button	at	the	bottom	of	the	popup	window.

Now,	visit	the	single	listing	page	of	a	listing	in	the	frontend.	If	the	listing	has	a	valid	RSS	feed	URL	entered	for	the
Social	Accounts	field,	then	the	RSS	Feed	section	should	look	something	like	below:

Adding	styles	to	your	template	file

Although	we	were	able	to	display	an	RSS	feed	for	listings,	it	may	not	look	pretty	because	of	the	stylings	added	by	your
current	theme.	In	order	to	resolve	that	issue,	you	can	create	a	CSS	file	for	your	template	file	containing	custom	CSS
rules	that	will	be	applied	to	the	content	rendered	by	your	template	file.

The	name	of	the	CSS	file	will	be	the	same	as	that	of	the	template	file	but	with	a	.css	file	extension.	For	example	the
CSS	file	for	the	RSS	feed	template	file	will	be:

directory__listing-element_rss_feed.css

Simply	place	the	CSS	file	under	the	same	directory	where	your	template	file	resides.	The	system	will	then
automatically	load	the	CSS	file	when	rendering	the	template	file.

In	the	CSS	file,	you	can	use	the	following	CSS	class	which	is	assigned	to	the	parent		<div>		element	of	the	HTML
content	rendered	by	the	template	file.

drts-display-element-template-name-yyyy

where		yyyy		is	the	same		yyyy		part	used	to	name	the	template	file.	For	example	the	CSS	class	name	of	our	RSS
feed	element	template	file	will	be:

drts-display-element-template-name-rss_feed

Note:	There	is	no	CSS	class	name	for	display	template	files.

Let's	try	adding	some	custom	CSS	styles	to	RSS	feed	items	rendered	by	the	template.
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Note:	Some	themes	may	render	RSS	feed	items	perfectly	fine	without	adding	any	custom	CSS	rules,	and	the
following	is	for	illustration	purposes	only.

1.	 Create	an	empty	file	named		directory__listing-element_rss_feed.css		and	place	it	under		wp-
content/drts/assets	.

2.	 Copy	and	paste	the	following	CSS	rules	to	the	file	created	in	step	1:

.drts	.drts-display-element-template-name-rss_feed	ul	{

		list-style-type:	none;

}

.drts	.drts-display-element-template-name-rss_feed	li	{

		padding:	0.5em	0;

		margin:	0;

		border:	0;

		border-bottom:	1px	dashed	#ccc;

}

.drts	.drts-display-element-template-name-rss_feed	li:last-child	{

		border-bottom:	0;

}

.drts	.drts-display-element-template-name-rss_feed	li:before	{

		content:	'\f15c';

		font-family:	'Font	Awesome	5	Free	-	drts';

		float:	left;

		margin-right:	0.5em;

}

Note:	The		.drts		CSS	class	selector	was	added	to	ensure	the	custom	styles	override	the	CSS	rules	defined	by
the	current	theme.

3.	 Save	the	CSS	file.

Reload	the	single	listing	page	in	the	frontend.	The	RSS	feed	section	should	now	look	similar	to	below:

Additional	methods	and	helpers

$entity	object	methods

Below	are	some	of	the	additional	methods	that	can	be	called	through	the		$entity		object.

	string	getTitle()	

Returns	the	title	of	the	content	item.

	object	getAuthor()	
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Returns	a	user	identity	object	representing	the	author	of	the	content	item.

	string	getBundleType()	

Returns	the	content	type	name	of	the	content	item.

	string	getSlug()	

Returns	the	slug	of	the	content	item.

	int	getTimestamp()	

Returns	the	timestamp	value	of	the	date	the	content	item	was	created.

	int	getId()	

Returns	the	ID	of	the	content	item.

	array	getFieldValues()	

Returns	all	the	field	values	of	the	content	item.

	array	getFieldValue(string	$fieldname)	

Returns	values	of	a	specific	field.	This	is	equivalent	with		get_post_meta($entity->getId(),	$fieldName)		(or
	get_term_meta($entity->getId(),	$fieldName)		for	terms)	and		$entity->$fieldName	.

	mixed	getSingleFieldValue(string	$fieldName)	

Returns	a	single	value	of	a	specific	field.	This	is	equivalent	with		get_post_meta($entity->getId(),	$fieldName,
true)		(or		get_term_meta($entity->getId(),	$fieldName,	true)		for	terms)	and		$entity->$fieldName[0]	.

	string	getContent()	

Returns	the	full	content	value	of	the	content	item.

Helper	methods

Here	are	some	helper	methods	that	may	be	useful	to	use	in	your	template	file.	These	methods	are	called	through	the
	$this		variable	which	is	a	template	object	available	by	default	within	template	files.

	$this->Entity_PermalinkUrl(object	$entity,	string	$fragment	=	'',	string	$lang	=	null)	

Returns	the	permalink	URL	of	the	content	item	(	$entity	)	passed	to	the	method.

	$fragment		-	#	part	in	the	URL	to	append	to	the	URL.

	$lang		-	Pass	in	language	code	to	get	the	URL	of	the	content	item	for	a	specific	language	in	a	multilingual
directory.

	$this->Entity_Image(object	$entity,	string	$size	=	'medium')	

Returns	the	URL	of	an	image	file	associated	with	the	content	item	(	$entity	)	passed	to	the	method.	The	URL	of
the	first	image	file	will	be	returned	if	the	content	item	has	multiple	images.

	$size		-	One	of	thumbnail,	medium,	large,	full.

	$fieldName		-	Machine	readable	name	of	an	Image	type	field.	Use	this	parameter	to	get	the	URL	of	an	image
from	a	custom	field.

	$this->Summarize(string	$text,	int	$length	=	0,	string	$trimmarker	=	'...')	

Returns	a	summarized	version	(without	HTML	or	line	breaks)	of	the	text	content	passed	to	the	method.
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	$text		-	Original	text	value.

	$length		-	Length	of	summarized	text	in	characters.

	$trimmarker		-	String	added	to	the	end	of	the	summarized	text.

Example:

<?php	if	($content	=	$entity->getContent):?>

<p><?php	echo	$this->Summarize($content,	100);?></p>

<?php	endif;?>

	$this->UserIedntityHtml(object	$identity,	string	$format,	bool	$thumbnailOnly	=	false)	

Returns	an	HTML	fragment	representing	the	user	identity	passed	to	the	method.

	$identity		-	User	identity	object.

	$format		-	One	of	link,	link_thumb_s,	link_thumb,	thumb_s,	thumb.

link	-	User	name	with	a	link.

link_thumb_s	-	User	name	and	small	icon	with	a	link.

link_thumb	-	User	name	and	thumbnail	with	a	link.

thumb_s	-	Small	icon	image.

thumb	-	Thumbnail	image.

	$thumbnailOnly		-	Whether	or	not	to	return	thumbnail	image	only.	This	parameter	is	valid	only	when		$format	
is	link_thumb_s	or	link_thumb.

Example:

<?php	if	($identity	=	$entity->getAuthor()):?>

<?php			echo	$this->UserIdentityHtml($identity,	'link_thumb_s');?>

<?php	endif;?>
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System	Info,	Tools,	and	Logs
The	System	section	of	Directories	Pro	provides	useful	information	and	tools	which	will	help	you	with	day-to-day
maintenance	of	your	directories	and	debugging	errors.	Go	to	Directories	->	System	in	the	backend	to	view	the
section.

System	Info

The	system	info	section	lets	you	view	the	system	information	of	your	server,	WordPress,	and	the	current	status	of
Directories	Pro	components.

Tools
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Reload	components

This	tool	will	reload	all	components	to	ensure	they	are	in	sync	with	stored	data.	Make	sure	to	run	this	tool	after
updating	one	or	more	of	Directories	Pro	plugins.

Clear	cache

This	tool	will	clear	settings	and	content	currently	cached.	This	tool	will	also	let	you	reload	content	field	and
taxonomy	term	cache.	Use	this	tool	if	you	find	old	or	inconsistent	data	being	displayed	for	your	directory.

Run	cron

Use	this	tool	to	manually	run	cron.	This	tool	will	force	run	all	cron	tasks	currently	registered	by	Directories	Pro.

Clear	log	files

This	tool	will	clear	all	log	files	saved	under	/wp-content/drts/System/logs.

Recount	posts

This	tool	will	recount	the	number	of	posts	associated	with	each	content	item.	If	you	find	inconsistencies	with	the
number	of	posts	for	taxonomy	terms	and/or	the	number	of	reviews	for	listings,	run	this	tool.

Usually,	you	will	also	want	to	clear	taxonomy	and/or	field	cache	using	the	Clear	cache	tool	after	running	this	tool

Load	geolocation	data

This	tool	will	load	geolocation	data	(lat/lng	coordinates	and	timezone)	of	each	content	item	if	currently	empty.	Use
this	tool	if	one	or	more	listings	in	your	directories	do	not	have	any	geolocation	data	assigned.

Logs

Error	log

Any	error	occurred	while	running	Directories	Pro	will	logged	to	an	error	log	file	saved	as	/wp-
content/drts/System/logs/error.log.	Errors	are	always	logged	even	when	the	debug	mode	of	WordPress	is	turned
off.

Debug	log

Debug	level	messages	useful	for	debugging	or	testing	Directories	Pro	are	logged	to	/wp-
content/drts/System/logs/debug.log	when	the	debug	mode	of	WordPress	is	turned	on.

For	details	on	WordPress	debug	mode,	see	https://codex.wordpress.org/Debugging_in_WordPress
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Homepage	Control
Homepage	Control	is	a	free	lightweight	plugin	that	allows	you	to	manage	homepage	components.	Homepage
components	can	display	various	types	of	content	from	your	site	similar	to	widgets	but	can	only	be	enabled	on	the
homepage	of	your	site.	By	using	homepage	controls	included	with	Directories	Pro,	you	can	easily	create	a	nice
landing	page	for	your	directory	with	just	a	few	number	of	clicks	through	WordPress	Customizer	(Appearance	->
Customize)	without	writing	any	code	(including	shortcodes)	or	using	3rd	party	page	builders.

Note:	In	order	for	the	feature	to	work,	your	theme	must	be	calling	the	homepage	action	hook	where	homepage
controls	will	be	displayed.	This	does	mean	that	as	long	as	the	homepage	action	hook	is	called	properly,	homepage
controls	can	be	displayed	anywhere.

For	more	information	and	instructions	on	how	to	use	Homepage	Control,	see
https://docs.woocommerce.com/documentation/plugins/homepage-control/.

Directories	Pro	homepage	controls
The	following	homepage	controls	are	available	with	Directories	Pro:

Directory	Featured	Listings	-	Shows	featured	listings	in	auto	playing	photo	slider.
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Directory	Categories	-	Shows	categories	in	grid	view.

Directory	Locations	-	Shows	locations	with	photos	in	masonry	view.
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Directory	Listings	-	Shows	4	latest	listings	in	grid	view.

Directory	Reviews	-	Shows	6	latest	listing	reviews	in	masonry	view.
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Specifying	a	directory

By	default,	Directories	Pro	homepage	controls	will	display	content	from	the	first	directory	found	on	your	site.	If	there
are	multiple	directories	on	your	site	and	wish	to	specify	the	directory	from	which	to	fetch	content,	you	can	add	a
custom	field	to	the	page	with	the	field	name	set	to	drts_directory	and	the	machine	name	of	your	directory	as	the	field
value.
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GDPR	Compliance
Here	we'll	be	outlining	some	tips	to	help	you	comply	with	the	General	Data	Protection	Regulation	(GDPR)	privacy	law,
which	takes	effect	on	May	25,	2018.

Adding	privacy	policy	consent	checkbox
As	of	version	4.9.6,	WordPress	includes	a	tool	to	generate	a	privacy	policy	page	for	your	site.	If	you	are	using	the
custom	login	form	or	the	guest	post	feature	(see	User	Login/Registration	and	Guest	Posts),	you	can	add	a	privacy
policy	consent	checkbox	next	to	the	login	form	and/or	the	guest	post	form	with	a	link	to	your	privacy	policy	page	as
shown	below.

In	order	to	enable	the	privacy	policy	consent	checkbox,	follow	the	steps	below.

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Click	Directories	in	the	admin	sidebar.

3.	 Click	the	Settings	tab	and	then	the	Frontend	Submit	sub-tab.

4.	 Under	Guest	Post	Settings,	toggle	the	Add	a	privacy	policy	consent	checkbox	switch.

5.	 Under	User	Login/Registration	Settings,	toggle	the	Add	a	privacy	policy	consent	checkbox	switch	if	you
have	the	Show	user	registration	form	option	enabled.
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6.	 Scroll	down	the	page	and	press	Save	Changes.

Personal	data	export/erasure
If	your	directory	content	contains	personal	data,	you	can	tell	Directories	Pro	which	fields	are	used	to	store	those	data
in	your	directory.	This	allows	you	to	export	and/or	delete	personal	data	through	the	personal	data	export/erasure	tool
of	WordPress	in	the	backend.

When	you	add	or	edit	a	field	for	a	certain	content	type	(see	Adding	and	Managing	Fields	for	details),	you	will	see	a
setting	labelled	Personal	data	as	shown	below.

If	the	field	contains	or	will	contain	personal	data,	check	the	This	field	contains	personal	data	checkbox	in	the
setting.	Then,	select	how	the	owner	of	the	personal	data	stored	in	the	field	can	be	identified.

If	the	personal	data	contained	in	the	field	belongs	to	the	author	of	the	content,	select	Author	ID.	If	the	content	type	of
the	field	has	one	or	more	e-mail	address	fields,	you	can	select	from	one	of	them	if	the	personal	data	contained	in	the
field	belongs	to	a	user	that	can	be	identified	by	the	e-mail	address	entered	for	that	e-mail	field.

Cookies

Guest	author	cookie

If	a	user	submits	a	listing	or	review	on	your	site	as	guest,	a	cookie	will	be	saved	in	the	user's	browser.	This	cookie
includes	no	personal	data	and	simply	indicates	the	IDs	of	all	the	listings/reviews	that	the	user	have	authored.	It
expires	after	100	days.

List	layout	cookie

Whenever	a	user	switch	the	layout	of	the	List	view	on	the	directory	page	from	row	layout	to	grid	layout	and	vice	versa
using	the	layout	switch	button,	a	cookie	is	saved	in	the	user's	browser.	This	cookie	includes	no	personal	data	and
simply	stores	the	name	of	the	layout	that	has	been	selected	last.	This	is	so	that	the	selected	layout	is	kept	selected
even	when	you	navigate	to	another	page.	The	cookie	is	deleted	when	you	close	the	browser.
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Dummy	Content
The	Directories	-	Faker	plugin	lets	you	generate	dummy	content	for	your	directory.	You	can	generate	not	only	listings
or	reviews	but	also	categories,	locations,	and	tags.	It	also	lets	you	generate	content	for	any	custom	field.	It	is	a	useful
tool	for	you	to	quickly	preview	how	your	directory	looks	like	with	actual	content.

If	you	have	not	yet	installed	and	activated	the	Directories	-Faker	plugin,	follow	the	steps	below:

1.	 Login	to	your	website	if	not	yet	logged	in	and	go	to	the	WordPress	administration	dashboard.

2.	 Select	Plugins	->	Add	New	from	the	side	menu.

3.	 Click	the	Upload	Plugin	link	at	the	top	of	the	page.

4.	 Click	Browse...	and	then	locate	the	directories-faker-x.x.x.zip	(where	x.x.x	represents	the	version	number)	file
saved	on	your	computer.	If	you	do	not	have	the	file,	you	can	download	the	package	from
https://codecanyon.net/downloads.

5.	 Click	the	Install	Now	button.

6.	 Wait	until	the	page	refreshes,	and	then	click	the	Activate	Plugin	link.

Now	that	you	are	ready	to	generate	dummy	content,	follow	the	steps	below	to	generate	listings	for	your	directory.

1.	Setup	categories,	locations,	and	tags
If	your	directory	currently	does	not	have	categories,	locations,	and/or	tags	setup,	you	can	do	so	by	importing	demo
content	available.

Note:	We	will	use	the	demo	content	included	with	Directories	Pro	instead	of	generating	them	for	more	realistic	data.

1.	 Select	Categories	(or	Locations	or	Tags)	under	your	directory	menu	in	the	admin	sidebar.

2.	 Click	the	Import	button	at	the	top	of	the	page.

3.	 Select	Select	from	existing	CSV	files	for	CSV	File	and	then	select	Demo	categories	(or	Demo	locations	for
locations	or	Demo	tags	for	tags)	and	then	click	Next.

4.	 Select	the	fields	to	import.	You	can	leave	the	settings	as-is	and	click	Next.
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5.	 Configure	fields	to	import.	You	can	leave	the	settings	as-is	and	click	Next.

6.	 This	is	the	final	page	before	import:
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Number	of	records	to	process	per	request	-	The	import	process	is	triggered	through	AJAX	requests.	Set
the	number	of	content	items	that	are	imported	in	each	request.	If	you	are	unsure,	leave	it	as-is.

7.	 When	you	are	ready,	click	Import	Now.	You	will	see	a	real-time	progress	of	what	is	imported	and,	if	any,	failed.

2.	Generate	dummy	listings
1.	 Select	All	Listings	under	your	directory	menu	in	the	admin	sidebar.

2.	 Click	the	Generate	button	at	the	top	of	the	page.

3.	 Select	the	fields	to	generate	by	checking	the	checkboxes.	If	you	are	unsure,	it	is	usually	safe	to	leave	them	as-is.
Press	Next	to	proceed	to	the	next	step.
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4.	 Depending	on	the	fields	selected,	additional	settings	that	can	be	configured	before	generating	listings	are
displayed.
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Here	are	some	of	the	settings:

Title	(post_title)

Field	generator

Default	-	Generates	random	phrases	and	set	them	as	the	listing	title.

Company	Name	Generator	-	Generates	fake	company	names	and	set	them	as	the	listing	title.

Photos	(directory_photos)

Field	generator

Default	-	Choose	photos	to	be	used	as	listing	photos	from	the	WordPress	media	manager.

Picsum	Photo	Generator	-	Downloads	royalty	free	photos	from	https://picsum.photos/	and	use	them
as	listing	photos.

Location	(location_address)

Locations
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Random	-	Randomly	fetch	locations	setup	in	your	directory	and	generate	lat/lng	corrdinates	within
the	proximity	of	those	locations.	Recommended	if	you	already	have	locations	setup	int	your
directory.

Enter	new	location	-	Enter	a	location	address	(e.g.	USA,	California,	Tokyo,	etc.),	which	will	be	then
used	to	generate	lat/lng	coordinates	around	that	area.

Select	manually	-	Manually	select	one	or	more	locations	from	locations	setup	in	your	directory	and
generate	lat/lng	corrdinates	within	the	proximity	of	those	locations.

Note:	Any	of	the	options	above	require	a	valid	geocoding	provider	configured	in	the	map	settings	(see
Configure	Map	Libraries)	if	you	wish	to	automatically	fetch	lat/lng	coordinates	for	each	location
generated.

Reverse	geocode	lat/lng	coordinates	generated	for	each	item	-	Whether	or	not	to	use	the	geocoding
API	to	fetch	a	real	address	for	lat/lng	coordinates	generated	for	each	listing.	Requires	a	valid	geocoding
provider	configured	in	the	map	settings	(see	Configure	Map	Libraries).

If	you	are	unsure	about	these	settings,	it	is	usually	safe	to	leave	them	as-is.

5.	 Click	the	Next	button	to	proceed	to	the	final	step:

Number	of	item	to	generate	-	Enter	the	number	of	listings	to	generate.

Number	of	records	to	process	per	request	-	The	generation	process	is	triggered	through	AJAX	requests.
Set	the	number	of	listings	that	are	generated	in	each	request.	If	you	are	unsure,	leave	it	as-is.

6.	 When	you	are	ready,	click	Generate	Now.

Now,	sit	back	and	relax.	You	will	see	a	real-time	progress	of	what	is	generated	and,	if	any,	failed.

This	may	take	a	while	(up	to	several	minutes	per	request)	to	complete,	depending	on	the	fields	that	you	selected
to	generate	and	the	settings	of	each	field.
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3rd	Party	Integration
The	folloiwng	is	a	list	of	3rd	party	plugins	that	Directories	Pro	uses	to	add	extra	features	to	your	directory.

Advanced	Custom	Fields
For	details,	see	FAQ	-	Is	Advanced	Custom	Fields	supported?.

Better	Notifications	for	WordPress
The	Better	Notifications	for	WordPress	plugin	adds	notification	features	to	Directories	Pro.	For	details	on	notifications
in	Directories	Pro,	see	Notifications.

Breadcrumb	NavXT
Directories	Pro	supports	the	Breadcrumb	NavXT	plugin	to	display	breadcrumbs	for	your	directory.	For	details	on
displaying	breadcrumbs	in	Directories	Pro,	see	Displaying	breadcrumbs.

BuddyPress
BuddyPress	activity	stream	displays	activities	for	listings	and	reviews	in	your	directories.

Contact	Form	7
The	Contact	Form	7	plugin	can	be	used	to	add	a	contact	us	form	to	the	single	listing	page	of	your	directory.	For
details,	see	Contact	Us	Form.

Gravity	Forms
The	Gravity	Forms	plugin	can	be	used	to	add	a	contact	us	form	to	the	single	listing	page	of	your	directory.	For	details,
see	Contact	Us	Form.

Homepage	Control
The	Homepage	Control	plugin	lets	you	easily	add	widget-like	components	to	your	homepage.	For	details,	see
Homepage	Control.

Post	Views	Counter
For	details,	see	FAQ	-	Is	there	a	way	to	count	and	display	the	number	of	page	views	for	each	listing?.

WooCommerce
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https://codecanyon.net/item/directories-pro-for-wordpress/21800540/faqs/32846
https://wordpress.org/plugins/bnfw/
https://wordpress.org/plugins/breadcrumb-navxt/
https://wordpress.org/plugins/buddypress/
https://wordpress.org/plugins/contact-form-7/
http://www.gravityforms.com/
https://wordpress.org/plugins/homepage-control/
https://codecanyon.net/item/directories-pro-for-wordpress/21800540/faqs/32755


The	WooCommerce	plugin	lets	you	add	monetization	features	to	your	directory.	For	details,	see	Monetization.

WooCommerce	Subscriptions
The	WooCommerce	Subscriptions	plugin	lets	you	create	recurring	payment	plans	for	posting	listings	to	your	directory.
For	details,	see	WooCommerce	Subscriptions.

WordPress	Popular	Posts
For	details,	see	FAQ	-	Is	there	a	way	to	count	and	display	the	number	of	page	views	for	each	listing?.

WP	All	Import
The	WP	All	Import	plugin	can	be	used	to	import	listings	to	your	directory	from	various	sources.	For	details,	see
Importing	Listings	with	WP	All	Import.

WPForms
The	WPForms	plugin	can	be	used	to	add	a	contact	us	form	to	the	single	listing	page	of	your	directory.	For	details,	see
Contact	Us	Form.

Yoast	SEO
Directories	Pro	supports	the	Yoast	SEO	plugin	to	display	breadcrumbs	for	your	directories.	For	details	on	displaying
breadcrumbs	in	Directories	Pro,	see	Displaying	breadcrumbs.
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https://wordpress.org/plugins/woocommerce/
https://woocommerce.com/products/woocommerce-subscriptions/
https://codecanyon.net/item/directories-pro-for-wordpress/21800540/faqs/32755
https://wordpress.org/plugins/wpforms-lite/
https://ja.wordpress.org/plugins/breadcrumb-navxt/
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